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Welcome to Painter Classic

MetaCreations Painter® Classic is an 
easy-to-use version of the world’s leading 
paint program for graphic designers. With 
Painter Classic, you can simulate the tools 
and textures of Natural-Media®, from felt 
pens, charcoal, and colored pencils to 
watercolor and oils. 

As image-editing software, Painter Classic 
provides many powerful options that let 
you sharpen, soften, and retouch scanned 
photographs, clone artistically, or make 
your image appear as though it were 
painted on handmade paper. 

Before You Begin

Please take a moment to complete your 
Painter Classic registration. 

Registration entitles you to: 

• Technical support

• Software updates

• Special pricing on upgrades

• MetaWorld, the MetaCreations 
catalog

• Special pricing on MetaCreations 
product promotions.

The Painter Classic CD-ROM 
Contents

At MetaCreations, we think of 
Painter Classic as a design environment. 
In their studios, artists keep a variety of 
tools they use in their work—oils, pastels, 
different brushes, inks, paper, and canvas. 
As they purchase new media or tools, they 
are able to employ new and different 
techniques in their artwork. 
Painter Classic works in a similar fashion. 

The Painter Classic installer provides all 
the software tools you need to get started 
in your electronic studio. But once you get 
into Painter Classic, you’ll begin to want 
more “stuff.” That’s what the extra content 
on this CD-ROM is for.

The Painter Classic CD-ROM includes an 
incredible collection of seamless patterns, 
lighting presets, brushes, paper textures, 
Image Hose nozzles, photos, and a variety 
of Painter Classic libraries that add 
functionality to your new copy of 
Painter Classic. 

Minimum System Requirements

To run Painter Classic, you will need:

Macinto
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sup
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inst

• CD-

Window

• Win
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e the location of your CD-ROM 
e followed by the word SETUP in 
appropriate box in the Run dialog. 
example, if your CD-ROM drive 
ive D, type 

 

D:\SETUP

 

 in the 
mand line.

  

 Painter Classic info screen 
ears. Click Next to continue to the 
t screen.

  

ialog appears in which you may 
ct your installation options. Click 
ical to install the complete 
ter Classic program and all 

porting files. Click Compact to 
all the minimum file set needed to 
 Painter Classic. Click Custom to 
all only selected options.

he on-screen instructions to 
e the installation procedure.
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Installing Painter Classic 

MetaCreations Painter Classic is designed 
to be simple and straightforward to 
install. Complete the following steps to 
install Painter Classic from the 
Painter Classic CD-ROM. 

Macintosh

To install Painter Classic, Macintosh:

1. Insert the Painter Classic CD-ROM 
into your computer.

2. Double-click the Painter Classic 
Installer application. This brings up 
the installer splash screen. Click 
Continue to continue the installation.

3. The README file for Painter Classic 
appears. You may read this 
information now or print it out. The 
README file is also saved on your 
hard disk when you install 
Painter Classic. Click Continue to 
proceed.

4. A dialog appears in which you may 
select your installation options. Click 
Install to choose the Easy Install 
option, which will install everything 
including Painter Classic, and all 

supporting files. If you wish only to 
install selected options, select Custom 
Install from the installation pop-up.

5. The Custom Install brings up a list of 
the custom installation options. Select 
the items to install by clicking the 
checkbox next to each component. 
Click Install to install these items.

6. Follow the on-screen instructions to 
complete the installation procedure.

Older versions of some INITs, CDEVs, 

and drivers may be incompatible with 

Painter Classic. If you have trouble 

running Painter Classic, you might try 

using an INIT manager to restart your 

computer with all extensions turned off. 

If the trouble disappears, it means one 

of your extensions is incompatible with 

Painter Classic.

Windows

To install Painter Classic, Windows:

1. Insert the Painter Classic CD-ROM 
into your computer.

2. In Windows 95/NT, click the Start 
button, and select Run...
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Personalizing Your Software

The first time that you run Painter Classic, 
you will be asked to enter your name and 
your Painter Classic serial number. Your 
serial number can be found on the READ 
ME FIRST card in your Painter Classic 
can, or on the Painter Classic CD-ROM 
jacket.

Setting Memory and Printing 
Options

Macintosh

By default, Painter Classic uses the 
smallest possible amount of memory. If 
you have more memory in your system, 
you can significantly improve the 
performance of Painter Classic 
(particularly with large image files) by 
increasing the memory partition size.

To change Painter Classic’s memory 
partition, first determine how much 
memory you have available. If 
Painter Classic is running, quit 
Painter Classic, then switch to the Finder 
and choose About This Macintosh… from 
the Apple menu. Set Painter Classic’s 
memory size to a number less than the 
Largest Unused Block size that is available 
when you have all the applications loaded 
that you normally use when you run 
Painter Classic. Write this number down 
and subtract about 300K from it (to allow 

room for QuickTime). If you add new 
fonts or INITs to your system, this 
number may change.

To set Macintosh memory:

1. Find the Painter Classic application 
icon in the Finder. 

2. Click the icon to highlight it, and then 
choose Finder’s File menu> Get Info.

3. Click the Preferred Size field and enter 
this number. 

4. Click the Close box in the upper-left 
corner of this dialog to store this 
information back into the application.

Windows

Painter Classic has a preferences dialog 
that helps you optimize Painter Classic’s 
use of memory, printing speed, and 
display quality. Choose Edit menu> 
Preferences> Windows to display 
memory and printing options.

Physical Memory Usage

For best performance, choose Maximum 
Memory for Painter Classic and run 
Painter Classic with no other programs 
running in the background. Choosing 
Half Memory for Painter Classic will 
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About Your User Guide

This manual provides all the information 
you need to get the most out of Painter 
Classic. It will help you learn the 
application and serve as a reference as you 
attempt more sophisticated procedures 
and effects.

This user guide assumes you are already 
familiar with basic Macintosh and 
Windows concepts—menus, dialogs, and 
mouse operations, such as clicking and 
dragging. If you need more information 
on these subjects, or on the Macintosh 
Finder or the Windows Desktop, refer to 
the Macintosh User’s Manual or the 
Microsoft Windows User’s Guide, 
respectively.

Each chapter in the users guide provides 
reference information on the features and 
function in Painter Classic, followed by a 
tutorial which teaches you how to use 
Painter Classic’s features to create 
artwork. 

Detailed information about all of the 
features in Painter Classic are provided by 
the on-line help.

Conventions

There are several conventions used to 
identify paths to certain tools and 
controls. The convention to a menu 
follows the rule of the menu name> 

menu item. The convention to a palette 
follows the rule of the palette name: 
subpalette name or palette item. The 
special rule for the Controls palette is 
Controls Palette: particular tool.

Modifier Keys

When a modifier key differs between the 
Macintosh and Windows platform, the 
Macintosh modifier is listed first followed 
by a slash and the Windows modifier key. 
Option/Alt means Macintosh users press 
the Option key and Windows users press 
the Alt key.

On-Line Help 

Painter Classic’s main source of 
documentation is the on-line help. The 
help file contains a wealth of information 
from the Painter Classic User Guide. With 
the Painter Classic Help system, you can 
do keyword searches, and set bookmarks. 
The help system can be accessed from 
within Painter Classic, using the Help 
menu.
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2. Use the Contents tab to view the table 
of contents. Select a “book” icon and 
then click Open to see the topics 
available. To view a topic, select it and 
click Display. 

3. Use the Help Topics button to return 
to the table of contents. Use the Back 
button to retrace your steps.

4. The Index tab lets you search by 
keyword or topic.

Tool Tips

Tool Tips are displayed by default 
whenever you rest your cursor over an 
interface element. If you would like to 
turn them off, choose Hide Tool Tips 
from the Help menu.

Customer Support

Technical Support is free* to registered 
users of Painter Classic. There are three 
easy options to contact technical support 
for questions about installation, 
configuration or functionality. These 
options are: Web, e-mail and phone 
support. For questions about creative 
technique, please see the Creative Support 
section below.

You will find the answers to most of your 
questions within the pages of this User 
Guide. If you need further assistance, you 
may contact MetaCreations Technical 
Support in any of the following ways:

Web Support

Many of the answers to your questions are 
available 24 hours a day on our web site:

http://www.metacreations.com/support

In addition to frequently asked questions, 
our web site provides troubleshooting 
techniques, late breaking product news, 
and other resources to get the most out of 
Painter Classic.

E-mail Support

To answer your technical support 
question most effectively and quickly, 
please use the e-mail form provided to 
you on our web site:

http://www.metacreations.com/support 

If you do not have World Wide Web 
access, please send e-mail to:

painter_classic@metacreations.com
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xii     Welcome Painter Classic

MetaCreations reserves the right to 

change its support policies at any time.

Who is MetaCreations?

MetaCreations is a major force in 2D and 
3D graphic software, developing and 
marketing next generation products that 
unite traditional art and design 
techniques with digital technology. 
MetaCreations products are engineered to 
deliver real-time interaction, intuitive 
functionality and creativity to design 
professionals, graphics hobbyists and 
consumers who work on desktop 
computers. 

MetaCreations’ focus is maintained by 
three product values:

• Faithfully replicate Natural-Media® 
and real world looks in the digital 
medium.

• Facilitate and extend the range of 
creativity by allowing artists to do 
things they couldn’t do before.

• Capture human expression and allow 
the artist’s perspective and intent to 
show through.

For More Information 

For more information about 
MetaCreations’ products, see our World 
Wide Web site on the Internet:

http://www.metacreations.com
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You can use the Window menu or 
keyboard shortcuts to show/hide the main 
palettes:

• Command-1/Ctrl+1 Tools

• Command-2/Ctrl+2 Brushes

• Command-3/Ctrl+3 Art Materials

• Command-4/Ctrl+4 Controls

• Command-5/Ctrl+5 Scripts

 

The Tools and Controls 
Palettes

 

Painter Classic puts a variety of tools at 
your fingertips. In the Tools palette, you 
can find tools for mark making, filling 
with color, viewing and navigation, and 
selection tools. If the Tools palette is not 
displayed on your screen, you can display 
it by choosing 

 

Window menu> Tools.

 

 

A second palette, the Controls palette, 
contains options for the selected tool. The 
Controls palette updates as you select 
different tools to reveal the selected tool’s 

 

 main 

ls.
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Tools and Palettes

Painter Classic’s interface is organized 
across a series of main menus and a set of 
floating palettes. Several features are also 
available in the frame of the document 
window.

In this chapter, you’ll learn about the 
major features of the interface. You’ll learn 
the names, basic functions and main 
controls for each of Painter Classic’s tools.

You’ll also learn about Painter Classic’s 
palettes—how to switch between 
subpalettes, open drawers, choose items 
and other common functions.

You’ll also learn about 
libraries—collections of materials you can 
load into a palette drawer.

The Palettes

Painter Classic has four main floatin
palettes. The Tools palette, Brushes 
palette, Art Materials palette and Con
palette. Each of these palettes is listed
the Window menu.

The Art Materials palette has five 
subpalettes. You’ll learn more about 
working with these in “Subpalettes”
page 17. 

When you launch Painter Classic, the four
palettes are displayed by default—Tools, 
Brushes, Art Materials (Color) and Contro

Tools Palette

Brushes Palette

Art Materials Palette

Control Palette

Painter Classic’s Interface
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options. If the Controls palette is not 
displayed on your screen, you can display 
it by choosing Window menu> 
Controls.

As each tool is described in the 

following paragraphs, you may want to 

select the tool and experiment with the 

Controls palette options.

Navigation and Utility Tools

The Magnifier Tool

The Magnifier tool allows you to magnify 
areas of an image when you are 
performing detailed work, or reduce them 
to get an overall view of an image. To 
zoom out, hold down the Option/Alt key 
and click. 

You can access the Magnifier tool while 
any other tool is selected. Press 
Command-Spacebar/Ctrl+Spacebar and 
click to zoom in or 
Command-Option-Spacebar/
Ctrl+Alt+Spacebar to zoom out.

Double-click the Magnifier tool to set the 
zoom level to 100%.

You can also use the Controls palette to set 
the zoom level.

The Grabber Tool

The Grabber tool gives you a quick way to 
scroll an image. You may also set the zoom 
level on the Controls palette when the 
Grabber tool is selected.

You can access the Grabber tool from any 
tool by holding down the Spacebar. 

Double-click the Grabber tool to size your 
window to fit the screen.

The Rotate Page Tool

The Rotate Page tool lets you rotate an 
image window to accommodate the way 
you draw naturally. Click once with the 
Rotate Page tool to return to normal 
orientation. 
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rectangle to a set aspect ratio. When 
you’re ready to execute the crop, click 
inside the rectangle.

Tools that Work with Color

The Brush Tool 

The Brush tool is used to paint strokes on 
the canvas. You can set opacity, grain, and 
drawing style (Freehand or Straight Lines) 
in the Controls palette. 

In Freehand or Straight Lines mode, hold 
the Shift key to constrain lines to 0°, 45° 
and 90° angles.

The Brush tool represents a category of 
marking tools. Within the Brush category 
are pencils, pens, chalk, an airbrush, oil 
paints, watercolors, and more. You’ll 
choose specific brushes from the Brushes 
palette. Double-click the Brush tool to 
open the Brushes palette. For more 
information on the Brush tool, refer to 
“Painting” on page 47.

The Controls palette can be used to set the 
brush size, opacity, and grain.

The Paint Bucket Tool

The Paint Bucket tool lets you fill an area. 
The Controls palette shows choices for fill 
materials. The Tolerance and color 
Feather sliders let you control the extent 
of fill and opacity in neighboring areas. 
You may also choose to anti-alias your fill.

Drag with the Paint Bucket tool to 
constrain the fill to a rectangle. 

The Dro

The Dro
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The Controls palette: Crop tool lets you set the 
constraining aspect ratio.

The Controls palette: Brush tool lets you set the 
brush size, opacity, and grain.

The Controls palette: Paint Bucket tool lets you 
set what to fill with.

The Cont
currently
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The Oval Selection Tool

The Oval Selection tool allows you to 
create oval selections. 

When you create a selection, the 
coordinates are displayed in the Controls 
palette. Hold the Shift key and drag to 
create perfect squares and circles.

The Lasso Tool

The Lasso tool lets you draw a freehand 
selection. When you let up on your mouse 
or stylus, Painter Classic closes the path 
and makes it the selection.

The Controls palette: Lasso tool lets you 
set a zoom level so you can select a precise 
area.

You can add to or subtract from the 
selection using the Rectangle, Oval, or 
Lasso selection tools. Use the Shift key to 
add to the selection. Press Command/Ctrl 
to subtract from the selection.

The Adjuster Tool

The Adjuster tool allows you to move and 
manipulate a floating selection. The 
Controls palette lets you change opacity of 
the floating selection.

Text To
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Showing and Hiding Palettes

You can hide a single palette by clicking 
the close box. You can display a palette by 
choosing its name from the Window 
menu or using the key combination 
shown on the Window menu.

To hide all the palettes, choose Window 
menu> Hide Palettes or press 
Command-H/Ctrl+H. Choose 
Window menu> Show Palettes or press 
Command-H/Ctrl+H again to redisplay 
all the palettes that were on the screen.

Set up your palettes so you can find 

and identify controls more effectively. 

Make sure that open palettes don’t 

overlap other palettes you need. For 

example, the Color palette should never 

be covered by another expanded 

palette.

Subpalettes

The Art Materials palette has five 
subpalettes:

• Color

• Paper

• Grad

• Pattern

• Nozzle

The subpalettes are divisions of the main 
palette

Only one subpalette is displayed in the 
main palette at a time. 

To switch between subpalettes: 

✤ Click the icon for the subpalette you 
want. The chosen subpalette fills the 
main palette.

Collaps
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ons, a Library pop-up menu lists 
s in the palette, including those 
e drawer. 

st item in the Library pop-up is 

Load Library. This item lets you 

ve a new collection of items to fill 
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e items in the palette. You can also use 

 to load new libraries into a palette.
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To tear off a palette: 

✤ Drag the icon off the main palette. 
The palette pops open where you 
drop it.

When you no longer need the palette, just 
click the close box. 

You can’t tear off the current palette 

because one palette must remain 

(displayed) in the main palette. If you 

want to tear off the current palette, 

select a different palette first.

Viewing Additional Palette 
Controls

Many of Painter Classic’s palettes have 
additional controls that can be displayed 
for use or hidden to save space. If you 
have opened a subpalette, you can expand 
it by clicking the grow box. For example, 
the Color palette can be expanded to 
display the Color Variability sliders. Click 
the grow box again to hide them.
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Drag a palette off the main palette to view 
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To select an item:

✤ Click its icon or choose its name from 
the Library pop-up. 

A red border appears on the icon for 
the selected item. 

Using Palette Drawers

You can open the drawer of a main palette 
or subpalette to see the other items inside 
the drawer. The pushbar indicates which 
palettes or subpalettes have drawers.

Storing items in closed drawers gives you 
more screen space. You’ll find it handy to 
keep items on the drawer front that you 
use most often and retrieve other items 
when you need them. For example, you 
could keep your favorite paper textures on 
the front of the Paper drawer, and open 
the drawer to retrieve a paper texture you 
use rarely.

To retrieve items from inside a drawer, 
open the drawer by clicking the pushbar. 
(A down arrow on the pushbar means the 

drawer can be opened.) You can click 
anywhere on the pushbar to open and 
close a drawer. There are two options for 
retrieving items from drawers.

To take items out of a drawer by 
clicking:

✤ Open the drawer and click the item 
you want to use. 

The item will move to the front of the 
drawer, outlined in red to show that it 
is selected. Painter Classic 
automatically puts it in the place of 
the least recently used item.

Items that are already on the front of 

the drawer are ghosted inside the 

drawer. When you put an item away, it 

goes back to the same location so that 

you can always find it easily.
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2. Click and hold on its icon until a tiny 
green light appears under the icon. 
When you let go, the light stays on to 
show that the item is locked.

The item stays locked until you 
unlock it by holding down the icon 
again until the green light goes off. 

Painter Classic lets you lock all but 
one item on any drawer front (one 
item must remain unlocked to allow a 
space for any new item you might 
select). 

Libraries

What are Libraries?

A library is a collection of similar tools 
that can be loaded into a palette. For 
example, Painter Classic’s built-in brushes 
(and their variants) are contained in the 
default brushes library, which is loaded 

when you launch Painter Classic. You’ll 
find more brush libraries on the 
Painter Classic CD. 

Libraries are available for paper textures, 
patterns, gradations, brushes, nozzles, and 
scripts. You may have any number of 
libraries, but only one (of each type) will 
be open at a time. When you want other 
tools, you can load the alternate libraries.

The methods for working with all libraries 
are the same.

Loading Alternate Libraries

When you want to use the resources of a 
different library, you can load it.

To switch libraries:

1. Display the palette for the resource 
you want to work with, for example, 
Patterns.

2. Choose Patterns Library pop-up> 
Load Library. Painter Classic opens 
the Load Library dialog.

3. Use the directory window on the left 
to locate and select a saved library. On 
Macintosh, the panel to the right 
displays the icons for the contents of 
the selected library.

4. Sele
OK
reso
pale

Hold down an icon until a small green light 
appears, signifying that the icon is locked on the 
drawer front.
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Setting Width and Height

When you begin a new document, the 
width field is highlighted in the dialog. 
You can use the Tab key to move from 
field to field.

Choosing a Unit of Measurement 

The default settings are in pixels. You can 
change the measuring units by using the 
pop-up menu. Choose from pixels, 
inches, centimeters, points, picas, and 
columns. Columns are two-inch columns, 
and you can indicate how many columns 
wide and tall you’d like your image to be.

To set the width and height for a new 
document, enter a value for Width and a 
value for Height in the dialog.

Use the New Picture dialog to set your image 
size, paper color, resolution, and picture type. 
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Working in Painter Classic

In Painter Classic, you work in a 
document that is displayed in the 
document window. The document 
window offers navigation and guide 
features that will help you work. 

As you develop imagery, you’ll save your 
document to a file. Painter Classic’s native 
file format is RIFF (RIF in Windows), but 
the program supports numerous other 
formats for saving and opening files and 
offers other methods of import and 
export.

Every artist works in a unique way, and 
every computer system has its own 
configuration of memory, disks, printers, 
and accessories. Painter Classic 
Preferences let you customize the 
program for your own work style and 
optimum performance on your particular 
system.

Creating a New Documen

When you create a new document, yo
the picture width and height, as well
the resolution, and paper color. The 
resolution you choose will depend m
on your output device.

Create a new document by choosing
menu> New. The New Picture dialo
appears. 

Canvas Size

The Canvas Size shows how much R
the document requires. The saved siz
the document is roughly one-half to
one-fourth of this number, dependin
the number of colors used. A docum
with fewer colors or more white spac
compress more than a document fill
with many colors.
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 Paper Color

 choose the background paper 
en you create a new document. 

or will appear when you delete a 
ea or use the eraser to remove 

aper color when you create a 
:

ct File menu> New. 

PainterClassic.book  Page 22  Monday, May 18, 1998  10:31 AM
22          Chapter 2 Painter Classic

Setting Resolution 

Resolution, in general, refers to the 
number of dots per inch (dpi) that make 
up an image. In Painter Classic, dpi is 
referred to as pixels per inch (ppi).When 
you enter a value for Resolution, there are 
three kinds of resolution to consider:

• The monitor’s resolution, measured 
in pixels. Painter Classic is preset to 72 
pixels per inch. The resolution of your 
monitor may be different.

• The document’s resolution. You can 
assign the resolution when an image is 
scanned or when one is created in 
Painter Classic.

• The output device’s resolution, 
measured in dpi, and, in the case of 
halftones, lines per inch (lpi). 
Output-device resolutions vary 
depending on the press and paper 
you’re printing on. Generally, a 
photograph to be printed on glossy 
magazine stock will be output at a 
crisp 150 lpi, and at 85 lpi for more 
porous, and therefore more forgiving, 
newspaper stock.

In the New Picture dialog, setting the 
document’s pixels per inch is the same as 
setting its dpi. The default resolution 
setting of 72 pixels per inch means that 

your document’s dpi will also be 72. The 
image on-screen at 100% is the size it will 
be when it’s output. On most printers, 72 
dpi renders a coarse image, so you may 
want to choose a higher resolution value.

If you are using a personal laser printer, 
set your document size in inches, 
centimeters, points, or picas at the dpi 
specific to your printer. Your file will be 
output correctly, at the best resolution for 
your laser printer and at the proper size.

If you are using a commercial printer or a 
more sophisticated output device, the 
dimensions should always be set to the 
actual size it will appear in the printed 
piece. For the resolution, a good rule of 
thumb is to set your document’s pixels per 
inch to twice the desired lpi. So when lpi is 
150, the pixels per inch should be twice 
that, or 300; if the lpi is 85, the pixels per 
inch should be 170. It’s a good idea to 
check with your service bureau if you have 
questions about output-device resolution.

Resolution and Screen Appearance

Because Painter Classic opens and 
displays an image at 72dpi, a 300dpi 
image will be displayed at four times its 
actual size. Each dot in the Painter Classic 
image will occupy one pixel on your 
display. The display pixels are four times 
the size of your image’s pixels. Put another 
way, at 300 pixels per inch, your 
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 open documents from other 
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t medium. 
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2. Click the Paper Color color chip. The 
system color picker appears.

3. Choose a color and click OK.

To change an existing paper color:

At some point in the course of a project, 
you may decide to change the paper color.

1. Select the color you want as the 
primary color.

2. Select Canvas menu> Set Paper 
Color. The paper color set to the 
current color.

3. To see the change, you will need to 
delete areas of the image or use the 
eraser brush to erase areas (do not use 
a bleach variant). 

Paper color does not have anything to 

do with the Primary and Secondary 

Color rectangles on the Color palette. 

Painter Classic’s paper color can be 

compared to Photoshop’s background 

color.

Opening Existing Documents

Painter Classic will open files saved in any 
one of the following formats:

• RIFF. MetaCreations’ own native 
format (RIF)

• TIFF (TIF)

• PICT (PCT)

• Photoshop formats (PSD). 
Painter Classic drops layers and 
discards alpha channel information.

• Bitmap (BMP)

• PC Paintbrush (PCX)

• Targa (TGA)

• GIF. Painter Classic does not convert 
GIF animations to frame stacks.

• JPE
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If you change the existing paper color, you will 
need to delete an area to view the change.



 in:

k the Magnifier tool icon on the 
ls palette. The cursor changes to a 
nifier. The plus sign (+) on the 
nifier indicates that you are 
easing magnification—zooming 
he Zoom Level pop-up menu on 

Controls palette: Magnifier tool 
s the levels of magnification that 

ease each time you click with the 
nifier.

k the image. With each click, the 
ge grows by the selected zoom 
l. The percentage that the 
ument is magnified appears in the 
ge window title bar next to the 
ument name.

h the Magnifier tool to view an image 
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Clicking the Browse button displays a 
dialog that shows thumbnails, 
dimensions, and file types for all the 
documents in the folder.

3. From the Open dialog or the Browse 
dialog, open the document by 
double-clicking the file name, or 
selecting the file name and clicking 
Open.

Scanning/Acquiring

You can use the File menu> Acquire to 
bring images into Painter Classic by way 
of plug-in devices, for example a scanner. 
Painter Classic’s Illustrator EPS file 
import module is also located here.

Navigating Your Document

You can navigate through a document or 
image by changing the level of 
magnification (zooming in or out), 
scrolling to a different part of the image, 
or rotating the page. By navigation, we 
mean moving around a document, 
changing views, or moving the page.

Zoom to Fit Screen

By default Painter Classic opens a 
document at 100% view, but you can 
change the view to suit your needs. 
Choose Window menu> Zoom to Fit 
Screen and Painter Classic will generate a 
view of the entire image to fit the size of 
your monitor. 

You may also double-click the Grabber 

tool to zoom the image to fit the screen.

Zooming In and Out

Zoom in and out with the Magnifier tool 
or by choosing a zoom level on the 
Controls palette: Magnifier tool.

To zoom
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Browse in the Open dialog shows a thumbnail of 
images saved in Painter Classic, and lists 
dimensions in pixels, size, and its file format. 

Click wit
close-up.
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tcuts: To center an image with 

rabber tool selected, click once in 

age window. To use the Grabber 

hile another tool is selected, hold 

 the Spacebar.

ng an Image 

 rotate an image on the screen to 
odate the way your arm, wrist, 
d draw naturally. 

e an image:

ose the Rotate Page tool. (It’s 
er the Grabber icon on the Tools 
tte.)

 cursor changes to a hand with a 
ting finger and rotate page 

trols appear on the Controls 
tte.

g in the image to rotate the page. 
 arrow shows the angle. To 
strain rotation to 90° angles, hold 
n the Shift key while rotating the 
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To zoom out:

1. Hold down the Option/Ctrl+Alt keys. 
The plus sign (+) on the Magnifier 
tool turns to a minus sign (-).

2. While holding down the Option/
Ctrl+Alt keys, click the image. It 
shrinks by the selected zoom level. 

To change the zoom level:

1. Click the Zoom Level pop-up menu 
on the Controls palette: Magnifier 
tool.

2. Choose the zoom factor you need. 
You can see anywhere from 8.3% to 
1200% of your image in 
Painter Classic.

You can use the Magnifier tool while 

another tool is selected. Hold down 

Command-Spacebar/Ctrl+Spacebar to 

zoom in and 

Option-Command-Spacebar/

Ctrl+Alt+Spacebar to zoom out.

To magnify a specific area:

✤ Click the Magnifier tool icon on the 
Tools palette. Move the cursor to the 
drawing window and drag a rectangle 
around the area you want to magnify. 

The area inside the rectangle is magnified 
to the closest magnification level that fills 
the screen.

Double-click the Magnifier tool to set 

the zoom level to 100%.

Using the Grabber Tool

The Grabber tool gives you a quick way to 
scroll an image.

To scroll by using the Grabber tool:

1. Click the Grabber tool on the Tools 
palette. The cursor changes to the 
Grabber tool and the Controls 
palette: Grabber tool shows the 
zoom level. (You can change the zoom 
level from the Controls palette.)

2. Drag inside the image to pan or move 
your image.
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full-screen mode on and off:

s Command-M/Ctrl+M. The 
ge is centered on the screen 
out scroll bars.

s Command-M/Ctrl+M again to 
rn to its previous state, or choose 
dow menu> Screen Mode 

gle.

ter Classic features (except the 
tion button on the scroll bar) 
en in the full-screen mode. 

 position the image window 
re on-screen by holding down the 
r and dragging with your mouse 
s. 

n Mode allows you to view your image 
croll bars. 
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page. The new rotation angle appears 
on the Controls palette: Rotate Page 
tool. 

4. To return the image window to its 
normal position, select the Rotate 
Page tool and click once in the image 
window.

Shortcut: Hold down the 

Option-Spacebar/Spacebar+Alt keys to 

temporarily choose the Rotate Page 

tool. Continue to hold it down as you 

rotate the page with your mouse or 

stylus. To return the page to its original 

position, hold down the 

Option-Spacebar/Spacebar+Alt keys 

and click once in the image window. To 

constrain page rotation to 90° angles, 

hold down the Option-Shift-Spacebar/

Spacebar+Alt+Shift keys while rotating 

the page.

Using Full-Screen Mode

Painter Classic allows you to display your 
document window without scroll bars on 
a solid color background. 

To turn 
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e the canvas:

ose Canvas menu> Resize. 

ter Classic displays the Resize 
og. The dialog shows the current 
 new size, in terms of width, 
ht, and resolution.

er a new value for width, height, 
esolution. For more information 
hese values, refer to “Creating a 
 Document” on page 21.

 Constrain File Size option lets 
 choose how to deal with 
ensions versus resolution.

en Constrain File Size is enabled, 
 can change the measurements 
hes or centimeters) and 
ls-per-inch together. The pixel 
nt remains the same. 

en Constrain File Size is disabled, 
 can change the measurements 
hes or centimeters) independently 
e pixels-per-inch, and vice versa. 

 number of pixels in the image 
ges.

u choose Pixels or Percent as the 
 and enter a value, Painter Classic 
matically disables the Constrain 
on.
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Image Size Information

You can use the i (the international 
symbol for information) near the bottom 
left-hand corner of the image window to 
check image size.

To check image size and orientation:

✤ Move the pointer to the i icon in the 
lower-left corner of the image window 
and hold down the mouse button.

The width, height, and resolution of 
the image are displayed.

The window also shows how your 
image fits on the page. Page size and 
orientation (landscape or portrait) are 
based on those designated in the Page 
Setup dialog. The nonprinting area 
around the edge of the page is grayed.

If you change your image’s resolution 
or dimensions by choosing Canvas 
menu> Resize, you can use the 
information window to see how the 
changes affect the way the image fits 
on the page.

Release the mouse button to close the 
information window.

Changing Canvas Size

If you want the same image at a different 
scale, use Canvas menu> Resize. If you 
want more canvas to paint on, use Canvas 
menu> Canvas Size. If you want to crop 
the image, use the Crop tool.

To resiz
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The image size pop-up contains your image’s 
dimensions, resolution and file size. It also shows 
how your image fits on the currently selected 
printer paper size and orientation.



ll programs support drag and 

g into Painter Classic

agery you drag into a 
Classic document window 
s an image floater. You can drag a 
e from the Finder to a 
Classic document. The PICT 
s an image floater.

g out of Painter Classic

 also drag floaters and selections 
ainter Classic and into another 
ion or to the Finder. The exported 
 is in PICT format, supported by 
plications. 

ou drag to your Desktop, 
Classic creates a PICT Clipping 

g Text

t tool lets you add text to images 
dobe Type 1 or TrueType fonts. 
 b e rotated or scaled using the 

nds available in the Effects menu.
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4. When you’ve set your new size, click 
OK.

To change canvas size:

1. Choose Canvas menu> Canvas Size. 

Painter Classic displays the Canvas 
Size dialog, which has text fields to set 
the size adjustment for the top, left, 
bottom, and right of the canvas.

2. In the Adjust Size fields, enter the 
number of pixels you want to add to 
that side of the canvas.

You can enter negative values to 
reduce the canvas size.

3. Click OK. Painter Classic adds the 
canvas area you specified.

To crop the canvas:

1. Display the image at a scale where you 
can see all of it.

2. Choose the Crop tool.

3. Drag in the image to describe the 
rectangular area you want to keep. 
You can adjust the rectangle by 
dragging a corner or any of its edges. 

If you want to constrain the cropping 
rectangle to a certain aspect ratio 
enter the values for the width and 

height aspect you want into the 
Controls palette. Enable the Aspect 
Ratio check box.

The Controls palette: Crop tool 
shows the size and location of the 
cropping rectangle. 

4. When you’re ready to execute the 
crop, click inside the rectangle.

Drag and Drop Features

For both Macintosh and Windows, you 
can copy floating selections between 
Painter Classic’s documents by dragging 
from one window to the other. The 
selection keeps its properties in the 
destination; that is, selections beget 
selections. However, there can only be one 
active selection.

You can drag a selection directly. 

Painter Classic floats it automatically.

Dragging Between Programs

Painter Classic supports drag and drop 
between applications on Macintosh only. 
This can be a quick, convenient way to 
acquire or export imagery.

Not a

drop.

Draggin

Raster im
Painter 
become
PICT fil
Painter 
become

Draggin

You can
out of P
applicat
imagery
most ap

When y
Painter 
file.

Addin

The Tex
using A
Text can
comma



Painter Classic Basics 29

g and Scaling Text

u’ve created a text string using the 
l you can rotate or scale just as 
ld any other floater. The Effects 

 Scale or Rotate commands 
 controls for rotating and scaling 
 the Flip Horizontal and Flip 

 effects to mirror text.

g Documents

e and save a document, choose 
nu> Save As. 

pop-up menu for Type 
osh) or Save As Type (Win 95) to 
r document in any of the formats 

Classic supports.

ave As dialog to save Painter Classic 
variety of formats.
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To add text:

1. Choose the Text tool from the Tools 
palette.

2. In the Controls palette: Text tool use 
the Point Size slider to choose a point 
size. 

3. In the Controls palette: Text tool 
choose a font from the Font pop-up 
menu. Fonts with an bullet after their 
name are Adobe Type 1 fonts.

4. Click in the image where you want to 
start the text. Remember, you can 
move the text shapes after you create 
them.

5. Type the text you want. You may press 
Return/Enter to “carriage return” to 
the next line.

If you make a mistake while typing, you 
can press the Delete/Backspace key to 
delete, but only if you haven’t moved your 
insertion point. 

Editing Text

Once you’ve finished typing text it only 
remain editable until you click another 
tool, then it becomes a floating selection. 
You can edit the selection by repositioning 
it or rotating it, but the text string cannot 
be edited. 

Kerning Text

While you type you can kern individual 
letters using the arrow keys. Kerning is the 
process of adjusting the spacing between 
letters. A letter is only editable until you 
type a new letter.

The Right and Left arrow keys move 
individual letters closer or further apart, 
while the Up and Down arrows move 
letters up and down.

Repositioning Text

You can reposition text using the Adjuster 
tool. When you click the Adjuster tool the 
text string becomes a floater that you can 
position anywhere in your image.
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To create text click the Text tool and choose a font 
on the Controls palette.

This text effect was created using the arrow keys.
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ant your image to have 
ency, click the checkbox for 
Transparency. Most programs 
lay GIF files support 
ency, but for those that don’t, you 
pecify the color of the 
rent” area. If your image will be 
d on the World Wide Web, click 
o button for Background is 
Gray. You can also choose to use 
ground color of your WWW page 

ing the radio button for 
und is BG Color.

grams that support transparency, 
ection will determine which areas 
sparent and which are not. Use the 
 Data button to see the 
ency of your image. Transparency 
yed in the preview window by a 
lar lattice. You may toggle 
 the Preview window and your 
GIF options to get exactly what 
t.

formation on creating a selection, 

to “Creating a Selection” on 
 68.

he checkbox for Interlace GIF File 
mage will be displayed on a 
page. 
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RIFF Format

When you work in Painter Classic, you 
should always save in RIFF format. You 
can “Save As” finished work in other 
formats.

RIFF, Painter Classic’s native format, 
retains special information on your 
document. A Painter Classic RIFF will 
maintain a single floating selection (if it is 
in an image) so you can return to the file 
to reposition the selection. 

RIFF lets you compress files and save disk 
space with a lossless compression method. 

Select the RIFF format. Leave the 
Uncompressed option disabled if you 
want to minimize file size on your hard 
disk.

GIF File Format

Painter Classic allows you to save 
documents in GIF file format. GIF is an 8 
bit (or less) file format commonly used to 
display graphics on the World Wide Web. 

When you save a file as a GIF, you can 
choose from 4 up to 256 colors. You can 
choose how your colors will be displayed 
and what part of your image will be 
transparent. 

You will pick an Imaging Method to 
determine how your 24-bit Painter Classic 
document will be converted to the limited 
number of colors that GIF uses. If you 
choose Quantize to Nearest Color, 
Painter Classic will look at each pixel and 
will pick the nearest color. If you choose 
Dither Colors, Painter Classic will apply a 
pattern to the colors chosen to generate a 
more accurate, less banded result. Use the 
Preview Data button to see how the GIF 
file will look.  
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ugh you can save your images as 

CMYK EPS separations, 

er Classic can’t open or edit 

 files.

ou save a file in EPS-DCS, 
Classic opens the EPS Options 

CII) Picture Data

ust another way of storing 
pt information. Some page design 
s require that this option be 

. The file sizes will be 
mately twice as large when saved 
s option.

Options dialog appears when saving an 
the EPS format.
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JPEG File Format

Painter Classic supports the 
Joint-Photographic-Experts-Group 
(JPEG) file format. Because of its small 
file size and high quality, JPEG is 
commonly used to transmit files via 
modem. Unlike GIF, JPEG displays a full 
range of colors.  

JPEG allows you to compress your file on 
a scale of Fair to Excellent, where quality 
is directly proportional to file size. These 
quality settings will let you achieve 
compression ratios of less than 10-to-1, to 
greater than 100-to-1. JPEG is a “lossy” 
file format, meaning that a decompressed 
JPEG file will not be pixel-for-pixel 
identical to the original. However, because 
the JPEG algorithm takes into account the 
sensitivity of the eye to different colors, 
the higher quality settings should achieve 
visually satisfying results. 

To save a file as a JPEG, choose File 
menu> Save As and select JPEG from the 
list of file types. Click the Save or OK 
button and the JPEG Encoding Quality 
dialog appears. Excellent will compress 
the least but will retain the most data. Fair 
will compress the most but will lose the 
most data. 

It is best not to de-compress and 
re-compress a file multiple times. 
Although JPEG can compress and discard 
data that is not visible or obvious, the 
degradation of the data can affect the 
condition of your file. When a file has lost 
a significant amount of data, blocky 
patterns may appear in areas of the image. 
If you try to use Painter Classic’s Apply 
Surface Texture feature on a JPEG file, you 
may find it will accent the these patterns.

Saving in EPS

Painter Classic’s EPS files conform to the 
Desktop Color Separation 2.0 format 
(EPS-DCS 5-file format). Although 
Painter Classic saves files in EPS-DCS, it 
can’t read EPS-DCS. If you plan to save an 
image in EPS-DCS, it’s a good idea to save 
it in another format first so you will have a 
copy of it that you can reopen in 
Painter Classic.
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lug-ins may be stored anywhere 
 drive; however, you must identify 
ation to Painter Classic before 
 use them. For information on 
 your filter plug-ins directory for 
Classic, refer to “Other Raster 
s” on page 34.

Creations has made a 

ientious effort to maintain 

atibility with as many third-party 

 as possible. Some filters, 

ver, may run in Photoshop, but 

 Painter Classic. Check with the 

developer for compatibility issues 

en their product and 

er Classic. Please note that 

er Classic is an RGB-based 

am: it cannot run filters that are 

fic to CMYK or Grayscale modes. 

e Plug-ins

 plug-ins are available through the 
nu> Acquire submenu. Acquire 
s are usually used to support 
 capture devices (scanners and 
rabbers) or file formats that are 
t into Painter Classic. 
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Preview Options

The radio buttons under Preview Options 
tell Painter Classic whether to save 
preview data and in what format: No 
preview, Black and white preview, 
or Color preview. 

If you have an older laser printer, you may 
have to use the black and white preview to 
print these files on your laser printer. 
Although the preview or display is black 
and white, the color information remains 
intact.

Closing Files and Quitting

You can close the frontmost document by 
clicking its close box, choosing File 
menu> Close or using the keyboard 
shortcut (Command-W/Ctrl+W).

If you have any unsaved changes, a dialog 
asks if you want to save changes. Click Yes 
to save your changes or No to discard 
them.

Exit Painter Classic by choosing File 
menu> Quit or Exit. 

Plug-ins

Painter Classic supports plug-in 
architecture for Effects 
(Photoshop-compatible filters), Acquire 
and Export modules. MetaCreations and 
other software developers may create 
plug-ins that you can add to 
Painter Classic, extending its capabilities.

These types of plug-in modules are 
available from standard locations on 
Painter Classic’s menus and palettes. 
However, the actual operation of these 
plug-ins is determined by the plug-in 
developer. You should refer to the 
documentation that comes with your 
plug-in modules for instructions on how 
they work. 

Filter Plug-ins

Filter plug-ins appear below 
Painter Classic’s built-in Effects in the 
Effects menu. These Filter plug-ins 
usually offer specialized effects for raster 
images. Plug-in filters operate the same 
way that Painter Classic’s Effects operate. 
If you have an active selection, the filter is 
applied to the selection. If you have no 
selection, the filter is applied to the entire 
image. 
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 Preference

ou clone an image, Painter Classic 
 color information from the 
 as you fill in your clone. If you 
ke Painter Classic to display what 
he original you’re cloning, enable 
Indicate clone source with cross 
ile cloning option. 

omed-out Views Using 
eraging

oking at an image at less than 
ew, screen draw is faster if you 
is option unchecked, and slower 
e accurate if checked.

 warning when Drawing Outside 
n

g this box enables the warning 
ears when you draw outside a 
. The warning will not appear if 

 is unchecked.

Tracking—Setting Pressure 
ivity

ou draw with traditional media, 
unt of pressure you use with a 
ermines how dense and how wide 
okes are. Using a 
-sensitive stylus with 

Classic gives you this same kind of 
 Each artist has a different 
 or pressure level in a stroke. The 
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Export Plug-ins

Export modules are used to export image 
information, or to support special output 
devices. Many photo-realistic 
dye-sublimation printers include export 
modules because they provide better 
control over output quality than the 
standard print interface. Export modules 
are available through the File menu> 
Export submenu. If no Export modules 
are available, this menu will be 
grayed-out. 

Setting Painter Classic 
Preferences

Painter Classic has several different 
preference dialogs: General, Brush 
Tracking, Other Raster Plug-ins, and 
Undo.

General Preferences

To display the general Painter Classic 
preferences dialog, choose Edit menu> 
Preferences> General.

Cursor Setup

Painter Classic gives you many choices for 
the appearance of your cursor. To choose 
whether the cursor will be a triangle or a 
single pixel, check the radio button next 
to Drawing Cursor. To determine the 
direction the cursor will point (depending 
on your design and whether you’re left- or 
right-handed), click the appropriate 
button in the circle above Orientation. To 
select a cursor color that will contrast with 
your working area and will therefore be 
clearly visible, click the appropriate 
rectangle above Color.

Choosing a Default Scratch Disk

To select the disk volume that 
Painter Classic will put its temporary file 
on and will virtualize to, choose the 
volume name from the Temp File Volume 
pop-up menu. 

Units

Painter Classic displays image 
information using the units of measure 
you select; choose the units of measure 
from the pop-up menu.
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Use the General Preferences dialog to customize 
your Painter Classic application.



e the plug-ins folder on the 
sh:

ose Edit menu> Preferences> 
er Raster Plug-ins. Browse to 
ct the folder containing your 
-ins. 

k OK. Restart Painter Classic to 
vate this feature.

e the plug-ins folder in 
s 95:

ose Edit menu> Preferences> 
g-ins. Browse to select the 
ctory containing your plug-ins. 

k OK. Restart Painter Classic to 
vate this feature.

Setting Multiple Levels

e Undo allows you to undo and 
 to 32 levels of changes. The 
 of undo levels is set in “Undo 
ces,” found under Edit menu> 

nces> Undo. Five levels are set as 
t. 

vels apply across open documents. 
e levels set, if you have two 
nts open and you have “undone” 
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Brush Tracking preference lets you adjust 
Painter Classic to match your stroke 
strength. This is particularly useful for 
artists with a light touch. If a light stroke 
leaves no color on the canvas, you should 
use Brush Tracking to increase sensitivity.

You might also change brush tracking 
between phases of a project. You could use 
a light touch when sketching with a pencil 
brush variant, then set tracking for more 
pressure when you switch to an oil paint 
variant.

To set Brush Tracking: 

1. Display the Brush Tracking dialog, 
and choose Edit menu> 
Preferences> Brush Tracking.

2. Drag in the scratch pad in a “normal” 
stroke. Use the pressure and speed 
you prefer when drawing or painting. 

For specific adjustments, you can 
move the sliders. When you’re done, 
click OK.

Brush tracking is not saved between 
sessions. You should set Brush Tracking 
each time you use Painter Classic. 

Other Raster Plug-ins

Before Painter Classic can display your 
raster plug-ins (Photoshop-compatible 
filters) in the Effects menu, you must 
indicate where your plug-ins are located 
on your hard drive. Painter Classic will 
load plug-ins from the selected directory 
and its subdirectories.
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Use the Brush Tracking dialog to customize how 
Painter Classic responds to your stylus pressure 
and speed.
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 Option

ideo display driver is set to 16-bit 
ou may experience some color 
rities on your screen when using 
Classic. Checking No Device 
ent Bitmaps will correct this 
 with most 16-bit color video 

. If you are not using 16-bit colors, 
ckbox will have no effect on your 
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three operations on the first document, 
you can only undo two operations on the 
second.

Multiple Undo can use a significant 
amount of disk space. If you perform 
multiple operations on the entire image, 
the whole image must be saved for each 
undo step. Thus, be very judicious with 
the number of Undo levels you choose to 
save.

Setting Windows 
Preferences

Computers running Windows have some 
additional options.

Choose Edit menu> Preferences> 
Windows to display memory and 
printing options for Windows computers.

Physical Memory Usage

For best performance, choose Maximum 
Memory for Painter Classic and run 
Painter Classic with no other programs 
running in the background. Choosing 
Half Memory for Painter Classic will 

allow Painter Classic to run more 
efficiently when other Windows 
applications are running at the same time.

Printing Options

Free Memory for Printing will increase 
printing speed by writing the active image 
to disk, increasing the amount of memory 
available for the print manager and the 
printer driver.

No Print Banding disables print banding 
for devices that support it. Disabling print 
banding may help some PostScript 
printers, but will hurt the performance of 
some bitmap printers, such as the 
Hewlett-Packard DeskJet printers. Most 
dot matrix printers will be faster with No 
Print Banding left unchecked in the 
dialog. If you experience problems 
printing in landscape orientation, you 
may have to turn off banding by checking 
the radio button in the dialog.

Display

If your v
colors, y
irregula
Painter 
Depend
problem
displays
this che
system.

Use the Windows Preferences dialog to set 
preferences specific to Windows computers.
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The clone file is more than a copy: it 
maintains a pixel-for-pixel 
correspondence with its source 
document. For this reason, the source 
must remain open while you work in the 
clone.

Choose the Clone command to create a clone file. 
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Understanding Cloning and 
Tracing

Cloning and Tracing are features that will 
help you create great art quickly and 
easily. Cloning is the process of taking 
imagery from one area (the source) and 
re-creating it in another (the destination). 
Cloning is a two-step process: First you set 
the clone source, then you set and work in 
the destination.

The cloning brush variants let you “filter” 
the source imagery, reproducing it a 
variety of artistic styles like pastel chalk or 
watercolors.

Painter Classic’s Tracing Paper feature lets 
you re-create artwork by placing a 
transparent layer over an image. You can 
then paint over the outlines of the original 
to create a natural-media duplicate.

Cloning a Document

The easiest way to create the clone 
source-destination relationship betw
two documents is to clone a file.

Cloning is the easiest way to create 
Natural-Media renderings. 

Cloning and Tracing



-to-Point Cloning

-point cloning lets you clone 
 document between different 
 separate documents. 
-point cloning is also called offset 

.

 cloning brush you can combine two 

ithin a document with the source 
osshairs showing. 
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Using Tracing Paper

After cloning a document, you can set up 
an on-screen light box using 
Painter Classic’s Tracing Paper feature. 

The Tracing Paper feature lets you paint 
or draw over the original image. This way, 
you can easily create a duplicate of the 
original using Painter Classic’s brushes.

To use the Tracing Paper feature, the 

source and clone documents must be 

the same size.

Painting in the Clone

Painting with the cloning brushes is 
similar to painting with any other 
Painter Classic tools, except the cloning 
brushes take their color information from 
the clone source instead of the Color 
palette.

Point

Point-to
within a
areas of
Point-to
cloning

Use the Tracing Paper feature to view the clone 
source for tracing. 

When you turn the Tracing Paper off, you can see 
your tracing.

With the
images.

Cloning w
region cr
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Cloning and Tracing Tutorial

One of the most useful things you can do 
with Painter Classic is create artwork for 
the internet. 

Painter Classic contains several features 
that make it ideal for web design. It can 
save files in the formats most commonly 
used on the web. It can also create 
seamless tiles that can be used as 
backgrounds. 

When you use Painter Classic’s 
wraparound feature, you can paint off the 
Cloning and Tracing 39

side off the canvas and your stroke 
appears on the opposite side. You can also 
move the tile “seams” into the center of 
the image, where you can easily remove 
them.

This tutorial is designed to teach you the 
most commonly used cloning and tracing 
techniques for creating natural-media 
artwork from photo-realistic images. 

In this tutorial you’ll create the artwork 
for a web page. 



k the variant pop-up menu and 
ose Scratchboard Tool

w along the outline of the dog in 
image.

n off the tracing paper by clicking 
Tracing Paper icon again, or 
sing Command -T/Ctrl-T. This 
you check your work.

 Tracing Paper feature active, you can 
outline of the dog using the original 
 a guide.

u turn the tracing paper off you can see 
ine.
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Lesson 1: Cloning and Tracing

In this lesson you’ll create the artwork 
used for buttons on the web page. 

To clone a document:

1. Choose File menu> Open.

2. Select the file DALMAT and click 
Open.

This document will be the source 
document. A good source document 
contains well-defined imagery.

3. Choose File menu> Clone. 
Painter Classic creates a duplicate 
(clone) of the DALMAT file. This file 
appears with the words “Clone of” 
preceding the original document’s 
name in the title bar.

4. In the cloned image, choose Edit 
menu> Select All.

5. Press Delete/Backspace to remove all 
imagery.

6. Click the Tracing Paper icon. This 
turns on the tracing paper so you can 
see the original at 50% opacity.

7. Click the Brush tool in the Tools 
palette.

8. From the Brushes palette, click the 
Pens category.

If the Pens category is not visible, 
open the drawer and select the tool 
from there.

9. Clic
cho

10. Dra
the 

11. Tur
the 
pres
lets 

The file DALMAT will be the source document 
for cloning.

The Tracing Paper icon on the image window 
places a tracing paper layer over your image.

The Brush tool lets you paint with various art 
materials.

The Pen category of brushes lets you create a 
variety of pen-like brushstrokes such as those 
created by calligraphy pens, or scratchboard 
tools.

With the
trace the 
image as

When yo
your outl
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ose File menu > Open and open 
file FLAME. 

ose File menu> Clone Source > 
EMAN.

k the Brush tool in the Tools 
tte.

ME file will be used as the destination 

h tool lets you paint with various art 
.
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12. Continue tracing the original image 
until you have a complete drawing of 
the dog. 

You can switch tools to create 
different line widths.

Refer to “An Overview of Painting 
with Brushes” on page 47 for more 
on using different brushes.

13. Click the Airbrush tool and paint a 
shadow underneath the dog.

The other icons on the web page were 
created using this same technique. 

Lesson 2: Using Cloning to 
Combine Images

In this lesson you’ll create the main 
imagery for your web site by using the 
cloning brush to combine two images. 

Then you’ll turn photo-realistic images 
into painted elements by using the Clone 
Color feature.

To combine images using a cloning 
brush:

1. Choose File menu > Open and open 
the file FIREMAN. 

2. Cho
the 

3. Cho
FIR

4. Clic
pale

Use the airbrush tool to create a drop shadow.
The FIREMAN file will be used as the source file 
for cloning.

The FLA
file.

The Brus
materials



 combined two images to create a 
his new image uses photo-realistic 
s. You can turn these elements 
nted elements using the Clone 
ature. With the Clone Color 
nabled, any brush can be used as 
g brush.

e Clone Color feature is enabled, 
r of your brush is determined by 
e Source image. This is the best 
etting Natural-Media renderings 
otographic source material.

 haven’t set a clone source, 

r brushes paint with imagery from 

urrent Pattern.

e color with a brush:

k the Brush category in the Brush 
tte.

ose Big Wet Ink from the variant 
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hes category variant let you create 
kes like those produced by different 
rtist brushes, such as ink and sable tip.
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5. Choose the Cloners category from the 
Brushes palette. If the category is not 
visible, you’ll need to open the palette 
drawer.

6. Click the Variant pop-up menu and 
choose Soft Cloner.

The Soft Cloner variant reproduces 
with low opacity and soft edges.

The Straight Cloner variant 
reproduces the source imagery 
directly. 

Other variants use paper grain and 
specialized dabs for particular media 
effects. For example, the Chalk Cloner 
copies the source image in the style of 
pastel chalk. 

7. In the Controls palette, set the Size 
value to 22.0 by either dragging the 
slider, or typing in a value.

8. Set the Opacity to 24%.

9. Select the FLAMES document 
window and drag the brush over the 
flames.

As you paint, the FIREMAN image 
appears.

You just
third. T
element
into pai
Color fe
option e
a clonin

When th
the colo
the Clon
way of g
from ph

If you

Clone

the c

To clon

1. Clic
pale

2. Cho
pop

Use the Cloners category variants to clone 
imagery one stroke at a time.

The Controls palette lets you set the properties of 
a selected brush or tool.

As you paint with the Soft Cloner brush, the 
FIREMAN image is combined with the FLAMES 
image.

The Brus
brushstro
types of a
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 3: Using Cloning to 
 a Seamless Background

sson you’ll create the background 
 web site. To do this, you’ll need to 
 seamless tile which will then be 
to fill up the background of your 

re two main ways of creating a 
s tile: by removing the edges from 
ing image such as a photo, or by 
 a new tile using the Wraparound 

esson you’ll be creating a seamless 
g the Straight Cloner brush. 
 5: Creating Patterns” on 
 shows you how to create a 
s tile using the Image Hose and 
paround feature.

 the tile image:

ose File menu> Open and select 
file STONES.
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3. In the Controls palette, set the Size of 
the brush to 3.0.

4. Set the Opacity to 20%.

5. Set the Grain to 100%.

6. In the Art Materials palette, click 
Color. The Color controls appear.

7. Enable the Clone Color option at the 
bottom of the palette.

8. Paint over the photographic elements 
in the image.

As you paint the imagery in the photo 
is recreated using the art material you 
selected.

Your image is now complete. You can use 
this color-cloning technique with any art 
material. You may want to experiment 
with the fireman image. Try using 
different art materials to re-create the 
photo imagery.

Lesson
Create

In this le
for your
create a
applied 
image. 

There a
seamles
an exist
creating
feature. 

In this l
tile usin
“Lesson
page 89
seamles
the Wra

To open

✤ Cho
the 

The Controls palette lets you set the properties of 
a selected brush or tool.

When the Clone Color option is selected, the 
color of the brush is set by the Clone Source 
image.

You can select a variant for the Cloners brush 
from the Variant pop-up.



 can turn off the wraparound 
acteristic on this image by 

osing Canvas menu> Disable 
paround. You can also click the 
 icon.

ou enable the Wraparound 
your tile automatically becomes a 
 This means that you can test your 
lling a document window with the 
 

 window with a pattern:

ose File menu > New.

ept the default settings and click 
 A new document window called 
TITLED appears.

ose Effects menu> Fill. The Fill 
og appears.

ialog lets you fill an area with a 
olor, or gradient.
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Now that you have a file to use as a 
tile, you’ll need to give the tile 
wraparound properties so it can fill a 
large area.

To create a wraparound tile:

1. Click the Star icon on the document 
window.

Notice that the Star icon is split. This 
shows that the image now has the 
wraparound characteristics:

A brush stroke dragged off the edge 
reappears on the opposite side of the 
image.

2. Click the Grabber tool in the Tools 
palette. 

3. Hold down the Shift key and drag the 
tile around the window until you can 
see the seams in the center of the 
image. 

For best results, do this at 100% scale, 
not when you’re zoomed in.

You
char
cho
Wra
Star

When y
feature, 
pattern.
tile by fi
pattern.

To fill a

1. Cho

2. Acc
Ok.
UN

3. Cho
dial

The STONES file will be used as the tile for your 
background.

When you’re working with a wraparound image 
the star icon appears split.

The Grabber lets you move an image within the 
document window.

Wraparound colors lets you paint off one side of 
your image onto the other side. The Fill d

pattern, c
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t you’re finished removing the 
ou’ll want to test the new tile.

a seamless background tile:

ct document window 
TITLED.

ose Effects menu> Fill. The Fill 
og appears displaying your new 

e sure Pattern is enabled and click 
.
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4. Enable Pattern and click OK. The 
entire window is filled using your tile. 

Now you can clearly see the seams. To 
create a more uniform background, you’ll 
need to remove them.

To use point-to-point cloning:

1. In the STONES file, make sure the 
Wraparound feature is enabled. If the 
Star icon on the document window is 
split, the tile is being wrapped.

2. With the Grabber tool selected, hold 
down Shift+Spacebar until the seams 
appear in the center of the window. 

3. Select Cloner brush and choose Soft 
Cloner from the Variant pop-up.

4. Hold down Control/Ctrl and click the 
source point.

5. Paint over the seams until you can’t 
see them any more. Change the source 
often to get more varied textures to 
paint with.

As you paint a crosshairs appears to 
show you the cloning source.

6. When you’re done painting, scroll the 
tile, using Shift+Spacebar, to make 
sure there are no more visible seams.

Now tha
seams, y

To test 

1. Sele
UN

2. Cho
dial
tile.

3. Mak
OK

The seams in your background become more 
obvious when you fill a large area with the tile.

You can select a variant for the Cloners brush 
from the Variant pop-up.

A green “1” appears at the point where you 
Control/Ctrl-click to indicate that this is the 
source point. The Fill d

color or g
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When the window is filled, you’ll see 
that there are no seams. 

Your tile is now ready to be used as a 
background for your web page. The 
pattern is a little overwhelming, so you 
may want to fade it a bit first.

To use pattern as background

1. Select the document window 
UNTITLED. 

2. Choose Edit menu> Select All.

3. Press Backspace/Delete. This removes 
all the imagery from the window. 

4. Choose Effects menu> Fill. The Fill 
dialog appears.

5. Enable Pattern.

6. Set to 30% Opacity. This creates a 
faded background for your web page.

Moving On

Once you’ve completed the lessons in this 
tutorial, you’ll have all the artwork you’ll 
need to create a web site. 

To use the artwork, you’ll need to save it 
in JPEG or GIF format and then upload it 
to a server. 

The techniques shown in this tutorial can 
be used to create a wide variety of 
artwork. In fact, cloning and tracing are 
the fastest ways to start most art projects. 
In the following tutorials, you’ll use 
cloning and tracing to help you begin 
more complicated projects. 

To learn more about cloning refer to the 
on-line help. 

You can select a variant for the Cloners brush 
from the Variant pop-up.



Painting 47

e a 
 the 

uld 
mage 

When you choose a color from the Color 
palette, the color you select appears in the 
front overlapping rectangle. This is the 
Primary Color. The back rectangle shows 
the Secondary Color, which is used to 
create two-color brush strokes and 
two-point gradations.

Choosing Paper Texture

In the natural world, a marking tool has 
different effects on surfaces of different 
texture. Painter Classic allows you to 
control the texture of the canvas to 
achieve the results you’d expect from 

ush 

Drag in the ring to select a hue. Drag in the 
triangle to pick the color.
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An Overview of Painting with 
Brushes

Painter Classic provides a drawer full of 
different brushes, each with its own 
characteristics. Many of the brushes are 
digital equivalents to the traditional 
media you’re familiar with. Using these 
brushes, you’ll create images that look like 
they were hand painted on real canvas or 
textured paper.

Using the Brush Tool

The Brush tool represents a category of 
marking tools. The Brushes palette lets 
you choose different types of brushes 
(called categories) —Pencils, Chalk, 
Crayons, Oils, Airbrush. The Brushes 
palette also lets you choose different 
varieties (called variants) of each brush.

Choosing Colors

Before painting, you’ll want to choos
color. Usually, you’ll pick colors from
Art Materials: Color palette. You co
also sample colors from an existing i
using the Dropper tool.

After you select the Brush tool, choose a br
and a variant from the Brushes palette. 

Painting 
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natural media on a given surface—pencil 
on watercolor paper, felt pens on cotton 
paper, chalk on the sidewalk, and so on. 

Choose a paper texture on the Art 
Materials: Paper palette. Painter Classic 
uses the current selected texture, so you 
can make a few strokes, then change the 
paper and make a few more strokes with 
different results. You can use the Grain 
slider on the Controls palette: Brush 
tool.

Setting Basic Brush Controls

Brush controls for Size, Opacity, and 
Grain are found on the Controls palette.

Size

The Size slider controls the size of the 
brush dab. The text field lets you enter a 
specific size (in pixels). 

As you drag the slider, a circle will appear 
in your document. The circle describes 
the size of the brush dab.

Opacity

The Opacity slider controls the degree a 
stroke “covers” or “builds up” on the 
underlying colors. You can also enter an 
Opacity percentage in the text field.

When Opacity is at maximum, the color is 
solid—completely covering, or building 
up, on the underlying colors.

With Op
be able 
colors. 

Grain

The Gra
penetra
enter a p
penetra
the grai

Moving
intensifi
allows le

Most of Painter Classic’s brushes interact with 
the current paper texture. 

The Size, Opacity and Grain sliders are found on 
the Controls palette: Brush tool.

Use the O
cover stre
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 Brushstrokes

pply a stroke, but want it less 
 choose Edit menu> Fade. Set the 
ount for the opacity you want as 
n the preview.

a Stylus vs. Mouse with 
r Classic

 Painter Classic’s brushes respond 
ressure information provided by a 
 stylus. Greater pressure can 
 the width of a brush stroke, the 
tion of color, or the degree of 
her effect, depending on the 
 

re using the mouse, you cannot 
is type of information, so 

Classic compensates by 
tically loading a special set of 
 specifically designed for using the 
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Moving the slider to the left reduces the 
stroke’s penetration, which reveals more 
texture. 

Drawing Freehand vs. Straight 
Lines

Painter Classic lets you paint in one of two 
modes: freehand and Straight Line. Radio 
buttons on the Controls palette: Brush 
tool lets you set the mode.

In Freehand mode you can drag in any 
motion or direction. The stroke follows 
the drag path. 

In Straight Lines mode each point you 
click is connected with a line. You can also 
drag the point to place it exactly. 

Using Straight Line mode you can draw 
polygons by placing a number of points 
and then closing the polygon shape by 
pressing Return/Enter.

To switch between modes. click the 
opposite radio button. So, to end 
Freehand mode, click the Straight Lines 
button and vice versa.

Keyboard Shortcuts

KeyDescription

bEnable Freehand mode

vEnable Straight Lines mode.

Undoing Brushstrokes

If you make a stroke you don’t like, choose 
Edit menu> Undo and Painter Classic 
removes it. Repeat the command to 
remove the previous stroke. You can set 
the level of undos as a preference. For 
more information, refer to 
“Undo—Setting Multiple Levels” on 
page 34.

Fading

If you a
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fade am
shown i

Using 
Painte
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drawing
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variant.

If you a
access th
Painter 
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mouse. 

Use the Grain slider to control how brush strokes 
react with the paper grain. 

The Draw Style options on the Controls palette: 
Brush tool let you switch between drawing 
modes.
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Painting Tutorial

Painter Classic was created to allow you to 
express you creativity easily. The wide 
number of brushes allow you express the 
creativity using almost any painting 
medium from oils, to pastels to 
watercolors. 

This tutorial is designed to help you 
explore the various brushes available in 
Painter Classic. There are so many 
varieties of brushes available that it the 
tutorial can’t show you them all, but 
you’ll learn the basic procedures for 
50     Chapter 4 Painter Classic

setting up a brush using the Controls 
palette and how to lay down brush 
strokes.

The project in this tutorial uses four 
different brushes using a variety of art 
materials. During the course of the 
lessons you’ll see how Painter Classic 
brushes can be used to create completely 
unique painting effects.

To learn more about painting or brushes 
refer to the on-line help.



Painting 51

he Brushes palette, click the Pen 
gory.

k the variant pop-up and choose 
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Lesson 1: Tracing with Brushes

In this lesson you’ll create the spring 
portion of the calendar artwork.

Before you start painting you’ll need to set 
up a file to act as your guide. To do this, 
you’ll need to clone an image and then 
trace it.

To set up a painting guide:

1. Choose File menu> Open. The Open 
dialog appears.

2. Select the file SEASONS and click OK. 
The file appears in a new document 
window.

3. Choose File menu> Clone. A new 
document window called “Clone of 
SEASONS” appears.

4. Select the new document window.

5. Choose Edit menu> Select All.

6. Press Backspace/Delete. This removes 
all the imagery from the window. 

7. Click the Tracing Paper icon in the 
document window frame. 

The original image is now visible 
through the tracing paper.

Once in tracing paper mode, you can 
trace the tree image from the original 
artwork.

To trace an image using a brush:

1. Click the Brush tool in the Tools 
palette.

2. In t
cate

3. Clic
Scra

4. In t
Col
mak

This is the file you’ll use to create a guide for 
painting.

The tracing paper icon makes the image 
semi-transparent so that you can see any image 
behind it.

The Brush tool lets you paint with ink art 
materials.

The Pen 

Pen varia
pens, suc

The Art M
the paint



 frame is now divided into four 
drants.

t you have a guide dividing the 
to four seasons, you can start 
 the imagery for each quadrant. 
adrant is produced in a different 
rial. The first quadrant you’ll be 
, Summer, is done using oils.

 2: Painting with Different 
terials

Classic’s brushes are designed to 
ce the look of painting with real- 
t materials. The type of brush you 
pends on the type of material you 

 reproduce. 

rants will act as a guide when you trace 
 of the SEASONS file.

PainterClassic.book  Page 52  Monday, May 18, 1998  10:31 AM
52          Chapter 4 Painter Classic

5. In the Controls palette, enable the 
Straight Lines option. 

With the Straight Line option 
enabled, the Pen tool will only draw 
straight lines.

6. In the document window, click once 
in the upper-left corner of the image.

7. Move the pointer to the upper-right 
corner of the image and click. A 
straight line appears.

8. Click the lower-right corner, then the 
lower-left corner, and then finally 
click the upper left corner again. 

You should now have a complete 
tracing of the frame. 

9. In the Controls palette, enable the 
Freehand option. This turns off 
Straight Lines mode. 

Whenever you want to end a line, 
you’ll need to enable the Freehand 
option.

10. Click the Straight Line option to start 
a new line.

11. Click the center of the top line and 
then click in the center of the bottom 
line. The frame is now divided in two.

12. Enable the Freehand option in the 
Controls palette to end the line.

13. Enable the Straight Line option again 
to start a new line.

14. Click the center of the left side of the 
frame and then click in the center of 
the right side of the frame. 
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The Controls palette lets you set the properties of 
the selected tool. The options available in the 
palette change as you select different tools.

The point where you first click will be used as the 
beginning of the line.

The second click tells Painter Classic where to 
end the line.

The quad
each part
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u make a stroke you don’t like, 
ose File menu > Undo. You can 
ose undo again to remove more 
kes.

e you’ve completed the tree trunk, 
 the Dropper tool again and 
ple the green of the leaves from 
original image. 

t over the leaves. If you want to 
te more texture in the leaves, use 
rt strokes.

eat the same process for the sky.

en you’re done, you can press 
mand-T /Ctrl- T to see what 

r painted image looks like.

u turn off Tracing Paper mode, you can 
your painted image looks like.
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Paints like oils and acrylics can be created 
using a brush from the Brush category, 
while inks are created by using a Pen 
category brush. Line drawings can be 
created using pencils, and chalk drawings 
can be done using a brush from the Chalk 
category. 

In this lesson, you’ll explore some of the 
various art materials that can be used to 
create images.

To paint using oils:

1. Choose the Brush tool from the Tools 
palette.

2. In the Brushes palette, click the Brush 
category.

3. Click the variant pop-up and choose 
Small Loaded Oils.

4. In the Controls palette set Size = 4.0.

5. In the Tools palette, click the Dropper 
tool.

6. Select the original SEASON 
document and click the brown color 
of the tree.

7. Click the Brush tool in the Tools 
palette to switch back to the oil brush.

8. In the Controls palette, set Size = 4.0. 

9. In the Clone of SEASONS window, 
trace over the tree trunk and 
branches. 

You’ll need to adjust the size of the 
brush to trace over the smaller 
branches. Try to stay with the black 
lines of the original.

If yo
cho
cho
stro

10. Onc
click
sam
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11. Pain
crea
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12. Rep

13. Wh
Com
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The Brush category brushes lets you paint with 
different types of paints, such as oils or inks.

The Dropper tool lets you select colors from the 
within an image.

As you paint using the brush, you’ll still be able 
to see the original image underneath.

When yo
see what 



r you’re done painting, choose 
vas menu> Tracing Paper to 
ove the original image from the 
e. 

 have half the image complete. 
ter quadrant is done using pastel 

o you’ll use a Chalk brush to paint 
.

t using Chalk:

ose the Brush tool from the Tools 
tte. 

u remove the original image from the 
 can see what your painting looks like.
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Now that you’ve completed the Summer 
quadrant, you can change art materials 
and move onto the Spring quadrant, 
which is created using the Artist brush.

The Artists brush creates brushstrokes in 
different artistic styles, such as 
impressionism or the pointillist style used 
by the painter Seurat.

To paint using the Artists brush:

1. Choose the Brush tool from the Tools 
palette. 

2. Click the Artists category in the 
Brushes palette. 

If the brush is not visible, you’ll need 
to open the palette’s drawer and select 
the brush from there.

3. Choose Seurat from the variant 
pop-up menu.

4. In the Controls palette set Size = 1.7.

5. Click the Dropper tool in the Tools 
palette. 

6. In the source document, click the 
brown color of the tree trunk.

7. Click the Brush tool in the Tools 
palette.

8. Paint over the tree trunk area in the 
upper-left quadrant of your 
document.

9. When you’re done with the tree truck, 
click the Dropper tool and sample the 
color of the leaves. 

10. Paint over the leaves in the upper-left 
quadrant.

11. When you’re done, click the Dropper 
tool again and sample the color of the 
sky. 

12. Afte
Can
rem
clon

You now
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To pain
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The Artists category of brushes lets you paint 
with different types of paints, such as oils or inks.

As you paint, the color is applied as little dots or 
in a pointillist style.

When yo
clone, you
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r you’re done painting, press 
mand-T /Ctrl -T to remove the 

inal image from the clone. 

ter quadrant is now complete. 
l quadrant, Fall, is done using 
lors.

t using watercolors:

ose the Brush tool from the Tools 
tte. 

k the Water Color category in the 
shes palette. 

u remove the original image, you can 
your painting looks like.

r Color category of brushes lets you 
 the effects of water colors.
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2. Click the Chalk category in the 
Brushes palette. 

If the icon is not visible, you’ll need to 
open the palette’s drawer and select it 
from there.

3. Choose Sharp Chalk from the variant 
pop-up menu.

4. In the Controls palette set Size = 5.

5. Click the Dropper tool in the Tools 
palette. 

6. In the source document, click the 
brown color of the tree trunk.

7. Click the Brush tool in the Tools 
palette.

8. Paint over the tree trunk area in the 
lower-left quadrant of the document.

If you’re using a stylus you can vary 
the amount of color you apply to the 
image by changing the pressure you 
use to apply a stroke.

9. When you’re done with the tree trunk, 
click the Dropper tool and sample the 
color of the snow. 

10. Paint over the snow area in the 
lower-left quadrant.

11. When you’re done, click the Dropper 
tool again and sample the color of the 
sky. 

12. Afte
Com
orig
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Chalk category of brushes let you paint with 
different types of chalks, such as pastels or 
charcoal.

As you paint, color is applied as strokes of chalk.
When yo
see what 
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r you’re done painting, press 
mand/Ctrl -T to remove the 

inal image from the clone. 

 quadrants are now complete. If 
 this painted look, you can use it 
wever, you can also re-create the 

glass effect by tracing over the line 
riginal image. This can be 
at time-consuming but the final 

 really worth the effort.

 over the stained glass lines:

ose the Brush tool from the Tools 
tte. 

u remove the original image, you can 
your painting looks like.
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If the category is not visible, you’ll 
need to open the palette’s drawer and 
select it from there.

Water color brushes are different 
from the other brushes.Water Color 
brushes paint into the “wet layer” 
which is a layer that floats over your 
image. The wet layer lets colors 
applied with the water color brushes 
to flow into each other and mix.

You can’t use Selection tools to select 
or delete areas of the wet layer. As 
well, you can’t use the Dropper tool to 
sample colors form the wet layer.

3. Choose Small from the variant 
pop-up menu.

4. In the Controls palette, set Size = 3.5.

5. Click the Dropper tool in the Tools 
palette. 

6. In the source document, click the 
brown color of the tree trunk in the 
lower-right quadrant.

7. Click the Brush tool in the Tools 
palette.

8. Paint over the tree trunk area in the 
lower-right quadrant of the clone 
document.

You can vary the amount of 
watercolor applied by painting over 
the same area several times.

9. When you’re done with the tree trunk, 
click the Dropper tool and sample the 
color of the leaves. 

There are different colors in the leaves 
so you’ll have to sample this area 
more than once.

10. Paint over the leaves in the lower-right 
quadrant of your image.

11. When you’re done, click the Dropper 
tool again and sample the color of the 
sky. 

12. Once you’re finished painting, choose 
Canvas menu> Dry to merge the wet 
layer with the rest of the image.

13. Afte
Com
orig
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To trace

1. Cho
pale

As you paint, watercolor is applied to the image. 
You can make the color darker by painting over 
the same area more than once.

When yo
see what 
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materials demonstrated in this 
are only a few of the materials 
e in Painter Classic. However, the 

es for setting up brushes and 
 are common to all brushes. 

rimenting with different art 
ls to create different types of 
f you want to learn more about 
, refer to the on-line help.
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2. Click the Pen category in the Brushes 
palette. 

If the category is not visible, you’ll 
need to open the palette’s drawer and 
select it from there.

3. Choose Scratchboard Tool from the 
Variant pop-up menu.

4. In the Controls palette, enable the 
Straight Line option.

5. Click the Color icon in the Art 
Materials palette to display the Color 
selector. 

6. Select Black as the foreground color.

7. Click the Zoom tool in the Tools 
palette.

8. Drag a marquee around the 
upper-right quadrant of the image. 
The area selected enlarges.

9. Make sure the Tracing Paper feature is 
enabled.

10. Click the Brush tool in the Tools 
palette.

11. Paint over the black lines to create a 
stained glass effect. 

12. Continue tracing lines until you’re 
happy with the effect.

13. Choose Canvas menu> Tracing 
Paper to remove the tracing paper.

Moving On

Now that you’ve completed the main 
artwork for your project, you can take the 
Painter Classic file into a page-layout or 
drawing program and add the calendar 
elements. 

The art 
tutorial 
availabl
techniqu
painting

Try expe
materia
effects. I
painting

The Pen is the best category of brushes to use for 
drawing lines.

The Zoom tool lets you enlarge areas of your 
image.

Once the Tracing Paper is removed, you can see 
your final artwork.
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Using the Image Hose

The Image Hose has the same types of 
controls as any other brush. Once you’ve 
selected the Image Hose brush, you select 
the types of images you want to paint with 
and then control the properties of the 
brush such as its scale, and opacity.

Nozzles

Nozzles are displayed in the Art 
Materials:Nozzles palette. The Nozzles 
controls let you see the nozzles available 
and lets you load new nozzles to use with 
the Image Hose. The drawer in the Nozzle 
controls displays the complete set of 
nozzles loaded with Painter Classic. 
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Using the Image Hose

The Image Hose paints with images— 
and not with just one or two images at a 
stroke, but with a variety of changing 
images. 

How it Works

The Image Hose is a brush. To use it,
must first load it with images. The im
are kept in special nozzle files (so cal
because— just as a regular nozzle con
the flow of water from a garden hose
the Painter Classic nozzles control th
flow of images from the Image Hose

Nozzles are stored in libraries. A num
of nozzles are automatically loaded i
the Painter Classic. You can load 
additional nozzle libraries to get new
images to paint with. Refer to “Load
Alternate Libraries” on page 20 for
more information on libraries.

Note: Painter Classic is not designed

create nozzle files. If you want to crea

your own Image Hose nozzles, you’ll

need to move up to use MetaCreatio

Painter.
Painter Classic’s Image Hose feature allows 
you to paint with images.

The Image Hose



direction” variant, you can change 
e of the images by changing the 
n of the stroke.

 Control factors are only available 

 nozzle is designed to take 

tage of the different factors.

ntrols Palette: Brush Tool 

 use the sliders on the Controls 
 Brush tool to adjust the opacity 
e images and to mix them with the 
ry color. 

acity slider allows you to make 
mages semi-transparent. If you 
e slider all the way to the left, the 
ecome invisible.
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You can load additional libraries using the 
Load Library option.

Scale

The Scale slider lets you control the size of 
image elements delivered by the Image 
Hose.

Drag the slider to the left to shrink the 
images. Drag it to the right to grow them. 
At 100%, the images equal their size in the 
nozzle file. 

Choosing an Image Hose 
Brush Variant

After loading a nozzle file, you need to 
choose the Image Hose brush and one of 
its variants from the Brushes palette.

These variants combine nozzle control 
factors with brush settings to create 
different hose effects.

The images flowing from the hose change 
as you make a brush stroke.The images 
available are determined in the design of 
the nozzle itself.

The nozzle control factor determines 
which images the Image Hose delivers 
from the nozzle. For example, with a 
“pressure” variant, you can hose larger 
images by increasing stylus pressure. Or 

with a “
the angl
directio

Note:
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You can
palette:
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The Nozzle palette lets you choose the 
nozzle file.

The Nozzle palette contains the Scale slider.

The Scale slider controls the size of the nozzle 
images.
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The Grain slider allows you to mix the 
secondary color with the nozzle images. If 
the slider is set to 100%, the nozzle images 
remain pure. As you move the slider to the 
left, more of the secondary color appears 
in the images. If the slider is set to 90%, 
Painter Classic mixes 10% of the 

secondary color to 90% of the image. This 
is a handy way to adjust the shading of 
image elements.

For information on selecting the 

secondary color, refer to “Choosing 
Colors” on page 47.

You can change the opacity of Image Hose 
strokes. 

You can turn down the Grain to mix-in the 
secondary color.
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Image Hose Tutorial

The Image Hose is the quickest way of 
creating sophisticated imagery. With this 
tool you can paint with images. So, if you 
use photos as nozzles your imagery will 
be photo-realistic.

The Image Hose can be a very versatile 
tool. Several Nozzles used in conjunction 
can create unique effects. This tutorial is 
designed to help you explore all the varied 
uses of the Image Hose. You’ll see how 
you can create complex artwork with very 
little effort. The project in this tutorial 
62     Chapter 5 Painter Classic

involves creating the art work used in a 
ski resort map.

This tutorial will teach you how to select 
nozzles, load new nozzles, and paint with 
the Image Hose brush.

To learn more about the Image Hose, 
refer to the Painter Classic on-line help.
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k the Nozzle icon in the Art 
erials palette. The Nozzle controls 
ear.

k the pop-up menu at the bottom 
e Nozzle controls and choose 
ll Forest.

the Scale slider to 10%.

he image, paint over the tops of 
mountain. 

 trees overlap as you paint, so you 
 paint rows of trees to create the 
 of a forest. 

le controls lets you select Nozzles and 
e of images produced from the Image 
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Lesson 1: Painting with the 
Image Hose

In this lesson you’ll add a forest and 
village to a mountain photo. These 
elements are created using two different 
nozzles. You’ll also learn how to set up the 
Image Hose brush.

To open the background image:

1. Choose File menu> Open and select 
the file SKYLINE. 

The background image appears in a 
document window.

2. Click the Brush tool in the Tools 
palette.

3. Choose the Image Hose category in 
the Brushes palette.

4. Click the Variant pop-up and choose 
Small Random Spray.

The different Image Hose variants 
determine how the images are placed 
within the stroke. Some variants place 
the images in a linear pattern while 
others place images randomly.

5. Clic
Mat
app

6. Clic
of th
Sma

7. Set 

8. In t
the 

The
can
look

The SKYLINE file acts as the background for 
your Image Hose project.

The Brush tool lets you paint with various art 
materials.

The Image Hose lets you paint using a stream of 
images.

The Nozz
set the siz
Hose.



he Art Material: Nozzles palette, 
 the Mediterranean Village 

zle. 

e nozzle is not visible, open the 
tte drawer and select it from 
e.

the Scale slider to 45%.

t over the lower-right corner of 
image.

er in the Nozzle palette lets you see all 
d nozzles in Painter Classic.

r the lower area of the mountain to 
mall village.
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As you paint, keep in mind that 
you’re creating trails, so space your 
trees accordingly.

9. When you’re happy with the look of 
the top of the mountain, change the 
scale of the image hose to 110%. This 
will produce larger trees.

10. Paint over the bottom area of the 
forest. Changing the size of the trees 
gives your image the illusion of depth.

Your forest is now complete. If you want 
to create a more detailed forest, you can 
create more trees at different scales.

Next, you’ll create a small village at the 
bottom of the slopes.

To switch nozzles:

1. Click the Image Hose variant pop-up 
in the Brushes palette and choose 
Medium Random Linear.

This variant produces a random spray 
of images in a linear fashion.

2. In t
click
noz

If th
pale
ther

3. Set 

4. Pain
the 

Start creating the forest by painting over the top 
of the mountain with a small Scale setting.

Paint over the lower area of the mountain with 
larger trees to give your image the feeling of 
depth.

The draw
the loade

Paint ove
create a s
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 2: Loading Nozzles

ge Hose can also be used to create 
g patterns using images. In this 
ou’ll create a border for your 
sing a skier image.

 a nozzle:

e sure the Nozzle button is active 
e Art Materials palette. 

k the pop-up menu and choose 
d Library. The Load dialog 
ears.

 the dialog controls to locate the 
ERS nozzle library in the 

ter Classic: Tutorial folder and 
 Open.

 dialog lets you browse your system for 
 nozzle libraries.
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Your ski resort is almost finished, so 
you can now use the Stones nozzle to 
add a few finishing touches.

5. Click the pop-up menu in the Art 
Material: Nozzles palette and choose 
Stones.

6. Set the Scale slider to 9%.

7. Paint in a few stone patches at the 
bottom of some of the tree groupings. 

8. Click the pop-up menu in the Nozzle 
controls and choose Cumulus Clouds.

9. In the Brushes palette, click the 
Variant pop-up menu and choose 
Medium Random Spray.

10. In the Controls palette, set the 
Opacity value to 35%.

11. Paint along the top of the image to 
add clouds.

You can also paint over the trees at 
the top of the image to add some 
haze.

The main image for your ski resort 
map is now complete. 

Lesson

The Ima
repeatin
lesson y
image u

To load

1. Mak
in th

2. Clic
Loa
app

3. Use
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Pain
click

Use the Stones nozzle to add some stone patches 
to your image.

The Controls palette lets you set the properties of 
a selected brush.

Use the Cumulus Clouds nozzle to add clouds 
and haze to the image.

The Load
available
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The SKIERS library is loaded into the 
Art Materials palette.

4. Set the Scale= 50%.

5. In the Brushes palette, click the 
variant pop-up and choose Small 
Sequential Linear. 

This variant produces a repeating 
stream of images.

6. Paint along the edges of the image 
within the green border. Hold down 
Shift to constrain the flow to straight 
vertical or horizontal lines.

The imagery for your ski resort map is 
now complete. The lines for the ski 
trails were created using the Brush 
tool. Refer to “Painting” on page 47 
for more on painting.

Moving On

Now that you have the imagery for your 
ski resort map, you can take the graphic 
into a page layout or illustration program 
and add the legend and logo. 

The techniques used in this lesson can be 
applied to any number of images. You can 
use different nozzles with different 
properties to create a wide variety of 
images. 

To find out more about the Image Hose, 
refer to the Painter Classic on-line help.

A thumbnail of the SKIERS nozzle appears in 
the Art Materials palette.
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Draw Outside

The selection protects the areas it encloses 
or covers. Opaque areas of the selection 
prevent brush strokes from reaching the 
canvas. Clear areas of the selection allow 
brush strokes to go directly to the canvas.

Draw Inside

Draw Inside effectively inverts the 
selection. Only the selected region accepts 
brush strokes. 

where 

Click the Draw Outside icon to draw outside 
your selection.

Click the Draw Inside icon to draw anywhere 
inside your selection.
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Understanding Selections

The selection marks off areas of the canvas 
for “special treatment.” The selection may 
protect an area from change, which is 
called masking, or describe the area that 
you want to change. 

There can only be one active selection at 
any given time. 

How Selections are Used

You may use the selection in several ways: 

• To constrain brush strokes. This 
works like putting a cardboard stencil 
over the paper you’re painting on.

• To isolate an area of the canvas for 
applying an image effect—Soften, for 
example. Painter Classic only softens 
the part of the image inside the 
selection.

• To choose the area of the canvas that 
you want to cut, copy, or move.

Drawing Modes

The drawing mode determines whet
the inside or outside of the selection
protected when you paint on an ima
You can use the pop-up icon in the 
bottom left corner of the document 
window to change modes.

Draw Anywhere 

The selection is disabled. Brush strok
are allowed anywhere on the canvas.

Click the Draw Anywhere icon to draw any
on the canvas.

Selections



wn the Shift key (before 
down) to add to the selection. 

n the Shift key to add to the selection.
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Creating a Selection

You can select a portion of the image with 
one of the Selection tools—Rectangle, 
Oval, or Lasso.

Selected area appear with a dashed outline 
around them, as shown in the next several 
figures.

Rectangle and Oval Selection Tools

These tools let you select rectangular and 
oval areas of your image. 

The Lasso Tool

The Lasso Tool lets you draw a freehand 
selection. When you let up on the stylus 
or release the mouse button, 
Painter Classic closes the path and makes 
the selection.

Adding to and Subtracting from a 
Selection

Normally, using a selection tool a second 
time replaces the first selection path. 
However, using a key combination, you 
can add to or subtract from the current 
selection.

Hold do
mouse-

Use the Oval, Rectangular, and Lasso tools to 
create selections.

Use the Lasso tool to draw freehand selections.

Hold dow
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g selection can be made 
nsparent. Decreasing Opacity in 
trols palette allows underlying 
 to show through.
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Hold down the Command/Ctrl key to 
subtract from a selection. The next 
selection path you draw “cuts out” from 
the current selection.

Floating Selections

Painter Classic allows you to move, copy, 
paste, and manipulate a selected region. 
In these cases, you’ll create a floating 
selection.

A floating selection is a portion of 
imagery (previously defined by the 
selection) that “floats” above the canvas.

The selection remains floating until you 
click outside the selection with a selection 
tool or the Adjuster tool, or switch to 
another tool. You can also choose Edit 
menu> Deselect to drop a selection.

When a selection is floating, Effects are 
applied only to the selected area. 

Floating the Selection

There are several ways you can float a 
selected area:

• Click inside the selection.

Hold down the Option/Alt key when 
you click to float a copy.

• Copy or cut, then paste the selection. 

• Use Effects menu> Rotate, Scale, and 
Flip commands; they all automatically 
float the image selection. 

Manipulating a Floating Selection

You can drag a floating selection 
anywhere in the image with the Adjuster 
tool. You can also nudge the selection one 
pixel at a time by pressing the Arrow keys 
on your keyboard.

You can
selection
menu.

Changin
Selectio

A floatin
semi-tra
the Con
imagery

Hold down the Command/Ctrl key to subtract 
from a selection.
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Selections Tutorial

Selections can be a powerful way of 
isolating parts of image to create different 
effects. Sometimes you’ll need to protect 
an area from painting, or you may just 
want to paint on a specific area.

This tutorial is designed to help you 
explore the world of selections. You’ll 
learn how to use the various selection tool 
to create selections. The tutorial will then 
teach you how to “float” selections so you 
move them and edit their size or rotation. 
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Finally, you’ll learn how to edit an image 
using a selection. You’ll use selection to 
add to existing artwork, as well as modify 
the an image. 

During the course of the tutorial you’ll 
create the artwork for a corporate 
advertisement.

To learn more about Selections, refer to 
the Painter Classic on-line help.
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Lesson 1: Creating Selections

In this lesson you’ll use the Lasso and 
Rectangular selection tools to edit an 
image. First you’ll create a herd of zebras 
from a single zebra and then add more 
terrain to the image.

To open the background image:

1. Choose File menu> Open and locate 
the file Painter Classic:Tutorial: 
HERD. The image appears in a 
document window.

To select an area using the Lasso tool:

1. Choose the Lasso tool from the Tools 
palette. 

2. Draw a freehand area around the 
zebra on left. 

3. Choose Edit menu> Copy.

4. Choose Edit menu> Paste.

The
sele

5. Clic
to th

6. Con
sele
zebr

7. Clic
the 
the 

The HERD image will be used as the background 
of your advertisement.

The Lasso tool lets you create freehand selections.

Use the Lasso tool to create a selection around 
the zebra shown. 

The Adju
selections

By movin
zebras. 



eat the same process with a strip 
ky.

t you’ve created a background, 
 start modifying it. 

 2: Using Selections for 
ng

ns can be used to edit the image, 
 can also be used to control which 
 the image are affected by the 
 tools or image effects. Protecting 

 your image is called masking.

 use selections to protect areas of 
ge, to restrict the painting area, or 
the range of an image effect.

u’re done the image should look 
g like this.
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You now have a whole herd of zebras. 

Next you’ll copy a strip of land and sky to 
fill in the empty areas of the image.

To create a selection using the 
Rectangular Selection tool.

1. Click the Rectangular Selection tool in 
the Tools palette. 

2. Drag the tool over a strip of grass at 
the bottom of the image.

3. Press Command-C/ Ctrl-C.

4. Press Command-V/ Ctrl-V.

5. Click the Adjuster tool in the Tools 
palette.

6. Click the pasted grass and drag it over 
the white space at the bottom of the 
image. 

Now the grass continues to the edge 
of bottom edge of the picture.

7. Rep
of s

Now tha
you can

Lesson
Maski

Selectio
but they
areas of
painting
areas of

You can
the ima
to limit 

You now have a herd of animals created by 
adding copies of the selected animal. 

The Rectangular Selection tool lets create 
rectangular selections.

Drag a rectangular selection around the area 
shown.

You can move the selected area to a different area 
of the image or create a more full scene.

When yo
somethin
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t in a swirling motion around the 
 of the zebras to create clouds of 
t. 

ice that as you paint, the selected 
a is unaffected by the brush.

t you’ve finished with the herd, 
 apply an effect to the entire image 
otecting the center zebra. 

ust Add Water brush to smear the 
 create a dust cloud effect.
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To protect an area using a selection:

1. Click the Lasso tool in the Tools 
palette.

2. Drag around the zebra in the center of 
the herd.

3. Click the Draw Outside icon at the 
bottom of the document window 
frame.

Now when you paint, the imagery within 
the selection is protected. Next, you’ll 
paint over the herd while leaving the zebra 
in the center untouched.

To paint on the herd:

1. Click the Brush tool in the Tools 
palette. 

2. Click the Water category in the 
Brushes palette. 

If the category is not visible, you’ll 
have to click the push bar to open the 
palette drawer and select the category 
from there.

3. Click the variant pop-up menu and 
choose Just Add Water.

4. In the Controls palette, set Size = 5.0.

5. Pain
feet
dus

Not
zebr

Now tha
you can
while pr

The Lasso tool lets you create freehand selections.

Use the Lasso tool to create a selection around 
the zebra in the center, as shown.

When the Draw Outside feature is enabled, 
everything within the selection is unaffected by 
the painting tools. 

The Water category of brushes lets you smear 
areas of an image.

Use the Controls palette to set brush properties.

Use the J
ground to



k the Draw Inside icon on the 
om of the document window 
e.

 painting area is now limited to 
central zebra. Now, you can use 
painting tools to finish the 
ertisement imagery.

t inside the selection:

k the Airbrush category in the 
shes palette.

he Controls palette, set Size = 1.0, 
city = 20%, and Grain = 32%.

he Art Materials palette, choose a 
ht red color.

e Draw Inside feature is enabled, you 
paint on the area inside the selection. As 
ge effects only affect the selected area. 

rush category of brushes paints soft 
kes.
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To invert a selection:

✤ Choose Edit menu> Invert 
Selection.

The entire image is now selected 
excluding the central zebra. Now when 
you apply an effect, it is applied only to 
the selection, so the zebra in the center 
will remain unaffected.

To apply an effect to a selection:

1. Choose Effects menu> Brightness/
Contrast.

2. In the Brightness/Contrast dialog, 
turn down the contrast and click Ok.

The imagery is almost complete. Next 
you’ll use a selection to restrict the 
painting area. That way you’ll be able to 
paint on the zebra while leaving the rest of 
the herd untouched.

To limit the painting area:

1. Choose Edit menu> Invert Selection 
so that only the center zebra is 
selected.

2. Clic
bott
fram

The
the 
the 
adv

To pain

1. Clic
Bru

2. In t
Opa

3. In t
brig

When you invert the selection, the entire herd is 
selected and the center zebra is not.

This is what you image should look like when 
you reduce the contrast.

When th
can only 
well, ima

The Air B
color stro
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t over the bottom of all the 
as’ legs.

 artwork is now complete.

g On

t you have the main imagery for 
rtisement, you can save the 
Classic file and bring it into a page 
rogram and add text and logos to 

ction techniques shown in this 
can be used for almost any 
 You can use selections when you 
combine different art materials on 
e image. This way you can 

ge should look something like this when 
ne.
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4. Paint on some of the stripes.

5. Choose a bright blue color and paint 
over a different set of stripes.

6. Continue painting on the zebra until 
you get an interesting mix of colors 
over all the stripes.

Most of the imagery is now complete. You 
can add some finishing touches by 
applying a brush to the whole document. 
To do this you’ll first need to remove the 
selection.

To remove a selection:

✤ Choose Edit menu> Deselect.

The selection is removed.

To smooth an area of the image:

1. Click the Water category in the 
Brushes palette.

2. Click the variant pop-up menu and 
choose Just Add Water.

3. Pain
zebr

The

Movin

Now tha
the adve
Painter 
layout p
it. 

The Sele
tutorial 
project.
want to 
the sam

You may want to paint on every other stripe to 
create an interesting effect. 

The zebra should look something like this when 
you’re done. 

The Water category of brushes lets you smear 
areas of an image.

Your ima
you’re do
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precisely limit where an art material is 
applied. To learn more about selections, 
refer to the Painter Classic on-line help. 



Art Materials 77

to 
 can 
ce 

able 
.

2. Select a color on the triangle by 
dragging the circle or clicking on the 
color you want.

Within the triangle, the colors are 
organized by value and saturation. 
Values span the triangle from top to 
bottom, with the top of the triangle 
being the highest value (white), the 
bottom the lowest value (black).

Saturation levels go from left to right. 
Dragging to the right produces the 
purest color within the predominant 
hue. Dragging to the left gives 
muddier or grayer colors.ow 

A diagram of the Standard Color palette.
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Working with Art Materials

Painter Classic’s Art Materials palette 
holds the media you apply to the 
canvas—color, paper textures, gradations, 
and patterns. You’ll use the art materials 
in two main ways:

• To set up the Brush tool for painting.

• To fill selections with the Effects 
menu> Fill command or with the 
Paint Bucket tool.

Working with Colors: The 
Color Palette

The Color palette is where you select the 
colors to use. You can also use the 
Dropper tool to sample or “pick up” a 
color from an image.

Using the Color Palette

To select a hue and color from the 
Standard Color palette:

1. Drag the circle on the color ring 
select the predominant hue. You
also select the hue by clicking on
anywhere on the ring. 

The triangle displays all the avail
colors within a predominant hue

The Standard Color palette expanded to sh
Color Variability sliders. 

Art Materials



trols palette: Dropper tool 
e HSV and RGB values for the 

GB values are given in both 
 and hexadecimal format (which 
seful in Web authoring).

 also swap the Primary and 
ry colors, by clicking in the 
s in the left corner of the palette. 

 Gradations: The Grad 
te

tion is a gradual transformation of 
r into another. Sometimes they 
d blends or fountains. 
Classic provides several different 
 gradations: linear, radial, spiral, 
ular. 

h Painter Classic comes with 
 full of gradations, you’ll want to 
me of your own. You can define 
rs and create a gradation between 
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Primary/Secondary Color Rectangles 

The color you select appears on the front 
rectangle in the pair of overlapping 
rectangles. The front rectangle shows the 
selected primary color. The back rectangle 
shows the selected secondary color. 
Whenever you start Painter Classic, black 
is the selected primary color and white is 
the selected secondary color. 

You can swap the primary and secondary 
colors by clicking the “swap” icon.

Don’t confuse the secondary color with 

what other graphics programs call “the 

background color.” In Painter Classic, 

the background color is the paper color. 

For more information about setting the 

paper color, refer to “Setting Paper 
Color” on page 22. 

Most of the time you’ll work with the 
primary color. The secondary color is for 
multicolor brush strokes, two-point 
gradations, and Image Hose effects. 

You can change the secondary color by 
clicking on the back rectangle, then 
picking a color. After changing the 
secondary color, click the front rectangle 
again. 

Sampling Colors from Imagery

In addition to choosing colors from the 
Art Materials: Color palette, you can use 
the Dropper tool to pick up a color from 
an existing image and use the color 
elsewhere. You can also choose the Clone 
Color option to use colors from the clone 
source image.

Using the Dropper tool

When the tool is active you can click on 
any portion of your image and the color 
under the tool will appear as either the 
Primary or Secondary color in the Color 
Palette.

To set whether the selected color becomes 
the Primary or Secondary color, click one 
of the color boxes in the Color palette.

From the Brush or Paint Bucket tools, you 
can temporarily switch to the Dropper by 
holding down the Command/Ctrl key.

The Dropper tool does not sample color 

from the Wet Paint layer.

The Con
shows th
color. R
decimal
can be u

You can
Seconda
swatche

Using
Palet

A grada
one colo
are calle
Painter 
types of
and circ

Althoug
libraries
create so
two colo
them. 

The Dropper tool lets you select color from an 
image.
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s of the gradation types.
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Working with Gradations

Use the Art Materials: Grad palette 
to select and adjust Painter Classic’s 
gradations. 

Click the Grad icon on the Art Materials 
palette to display the Art Materials: Grad 
palette. Click the palette pushbar to 
display additional gradations stored inside 
the drawer. Click the grow box to expand 
the palette.

Remember that gradations are stored 

in libraries. You can load alternate 

libraries for more grad choices.

In the center of the palette, the Preview 
window shows how the current settings 
affect the selected gradation. 

The Rotation Ring changes the angle of 
the gradation. Drag the red ball in the ring 
to change the angle. You can also select the 
angle by clicking once anywhere on the 
ring. The numeric value appears below 
the preview.

For a spiral gradation, you can use the 
Rotation Ring to change how tightly the 
spiral is wound. Hold down the 
Command/Ctrl key and drag around the 
Rotation Ring.

The Gradation Types on the right of the 
palette let you select from four types of 
gradations—linear, radial, spiral, or 
circular.

Click the Grad icon to display the Grad palette.

Example



es). If necessary, open the drawer 
he icon. If it’s in the drawer, drag 
 drawer front.

 Texture: The Paper 
te

xtures are useful in many ways. 
Classic’s brushes interact with the 
st as natural tools react with the 
of the surfaces on which you 
aper grains are also useful in 
g Surface Texture. 

erms “paper grain” and “paper 

e” are synonymous.

ing a Paper Texture 

aper textures available in 
Classic are displayed in the Art 
ls:Paper palette. These controls 

 set the paper type, and scale. 

the Two-Point icon or select Two-Point 
Library pop-up menu.
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The Gradation Orders at the bottom of 
the expanded Grad palette determine how 
a gradation behaves. The Preview Strip 
(above the gradation orders) shows the 
selected gradation order.

The top row (from left to right) orders the 
current gradation from left to right, left to 
right and mirrored, and right to left. The 
bottom row orders the current gradation 

from left to right and doubled, right to left 
and mirrored, and right to left and 
doubled. 

Creating Gradations

You can create your own gradations. It’s as 
easy as choosing the primary and 
secondary colors.

Creating a Two-Point Gradation

You can define a two-point gradation by 
defining two colors in the Art Materials: 
Color palette and then having 
Painter Classic create the gradation 
between them.

The gradation is created using the 
Two-point option in the Art Materials: 
Grad palette. The palette controls let you 
set the angle of the gradation and the 
gradation type.

The two-point option can be selected 
from the library pop-up in the Grad 
palette or by clicking the Two-Point icon 
(the one that looks like overlapping 

rectangl
to find t
it to the

Using
Palet

Paper te
Painter 
grain ju
texture 
mark. P
applyin

The t

textur

Select

All the P
Painter 
Materia
lets you

Examples of the gradation orders.

Click on 
from the 
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t using a cloning brush.

trol the Apply Surface Texture 
ct.

ave not set a clone source, the 
pattern is used in any operation 
g to clone source colors or 
ce. This means you can paint 
 pattern using a Cloner brush.

ing a Pattern

atterns available in Painter Classic 
layed in the Art 
ls:Pattern palette. A preview of 
erns is displayed across the top of 
tte and additional patterns are 
e in the palette drawer. You can 

 pattern libraries.For more 
tion on working with libraries, 
“Loading Alternate Libraries” 
 20.

ou select a pattern, Painter Classic 
 preview of the pattern, gives the 
ons of the tile image (Rows and 
s describe the number of pixels 
tally and vertically), and provides 
that lets you scale the tile in fills.
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The palette shows the dimensions of the 
paper (in pixels). When you select a paper 
texture, Painter Classic tiles it to cover as 
much canvas as needed.

Paper textures are stored in libraries. You 
can load alternate libraries for more paper 
choices. For more information on 
working with libraries, refer to 
“Libraries” on page 20.

The Scale slider at the bottom of the 
palette lets you set the scale of the paper 
grain. Higher values create paper with 
large grain, while lower values produce a 
finer grain.

Using Patterns: The Pattern 
Palette

A pattern is a repeating design. The 
smallest unit of a pattern is known as a 
tile. When you fill with a pattern, the tile is 
repeated across the area. 

All the patterns are displayed in the 
Pattern palette. Click the Pattern icon on 
the Art Materials palette to display the Art 
Materials: Pattern palette. Click the 
palette push bar to display additional 
patterns stored inside the drawer. Click 
the grow box to expand the palette.

Here are some things you can do with 
patterns:

• Fill selections with imagery.

• Pain

• Con
effe

If you h
current 
referrin
luminan
with the

Select

All the p
are disp
Materia
five patt
the pale
availabl
also load
informa
refer to 
on page

When y
shows a
dimensi
Column
horizon
a slider 

The Art Materials: Paper palette lets you select a 
paper type and set its scale.

Click the Pattern icon to display the Pattern 
palette. 



erance sets the amount of 
ance allowed from the color of the 
l you click on. With Tolerance set 
 the Paint Bucket fills only 
tiguous pixels that are very close 
e color of the pixel you click on. 

h Tolerance high, the Paint Bucket 
 a greater range of colors.

ther controls the fill opacity for 
ls outside the Tolerance range. 
h Feather low, pixels with 
hboring colors receive partial fill. 
easing the Feather “expands the 
hborhood.” (Typically, Tolerance 
t low when Feather is high.) The 
e distant a pixel’s color is, the less 
que the fill.

i-alias gives soft edges to the fill. 
ti-aliasing is desirable when 
her is zero or extremely low.) This 
ure is used primarily to eliminate 
gies” from a fill.

rols palette: Paint Bucket tool lets you 
hat to fill and what to fill it with. 
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Filling with Art Materials

Once you’ve selected an Art Material, 
you’ll need to apply it to your image. In 
some cases, such as color or nozzles, you’ll 
use the brushes to apply a material. In 
other case, such as with paper textures, or 
patterns, you’ll probably want to apply 
them to entire area. This is done using a 
fill. When you fill an area or the whole 
document, the selected art material is 
applied to the selection so that it fills it 
entirely.

Filling an Area

To fill an area with color, gradations, or 
pattern, use the Effects menu> Fill 
command or the Paint Bucket tool. 

Using the Fill command

When you fill a selected area with the fill 
command, the Fill dialog appears. This 
dialog displays a preview of your fill and 
lets you select the type of art material to 
use.

Using the Paint Bucket tool

The paint bucket tool works much like the 
Fill dialog. The only exception is that, 
whereas the Fill dialog can only be used to 
fill the entire image or a selected area, the 
Paint Bucket tool can fill any area of your 
image whether it’s selected or not.

The point where you click determines the 
center of the fill.

The Controls palette lets you select the art 
material to use for the fill and other fill 
properties.

• Tol
vari
pixe
low,
con
to th
Wit
fills

• Fea
pixe
Wit
neig
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Use the Fill command to fill a selection.

The Cont
choose w
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Art Materials Tutorial

Next to the Painting tools, Art Materials 
are the features you’ll use most to create 
artwork. Art Materials let you quickly fill 
areas with color, patterns, or gradations. 
Because Art Materials can be used to 
apply paper textures to your image, 
they’re ideal for creating printed imagery. 

In this tutorial you’ll be using different art 
materials to create the main imagery for a 
CD cover. 

The tutorial is designed to teach you how 
Art Materials 83

to apply different types of art materials in 
Painter Classic. You’ll explore the various 
controls available in the Art Materials 
palette and learn how to adjust the 
settings for different types of materials. 

To learn more about art materials and 
how to apply them, refer to the 
Painter Classic on-line help.



the Scale slider to 32%.

ose Effects menu> Fill. The Fill 
og appears. 

ble the Pattern option.

djust the Scale slider the dimensions 
ttern tile, shown in rows and 
, changes. 

ialog lets you fill the entire image or an 
 a pattern, color, or gradient.
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Lesson 1: Using Patterns

In this lesson you’ll use the Art Materials: 
Pattern palette to fill the entire image with 
a background pattern.

To set up an new document:

1. Choose File menu> New to open a 
new document. The New Picture 
dialog appears. 

2. Click the Height pop-up and choose 
inches. 

3. Enter 6 inches in the Height field. 

4. Enter 5 inches in the Width field. 

5. Enter 72 in the Resolution field and 
click Ok. A blank document window 
appears. 

To load a pattern:

1. Click the Pattern icon in the Art 
Materials palette. The pattern controls 
appear. 

2. Click the library pop-up and choose 
Load Library. The Load dialog 
appears.

3. Use the dialog controls to select the 
pattern in 
Painter Classic:Tutorial:SEA and 
click Ok.

An icon for SEA pattern appears in 
the palette.

To apply a pattern using the Fill dialog:

1. Click the SEA pattern icon in the Art 
Materials: Pattern palette.

2. Click the expand button in the 
top-right corner of the pallet to 
display additional controls.

3. Set 

4. Cho
dial

5. Ena

The Pattern icon displays the Pattern Controls.

Click the expand icon in the palette’s title bar to 
display additional controls.

As you a
of the pa
columns

The Fill d
area with
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inal Luminance is based on the 
t and dark values of the selected 
e source, which should be the 
ern “SEA.” 

g the default settings, the dark 
s become peaks and the light areas 
me valleys. 

 possible to invert the texture, 
ing the light areas high and the 
k low, by clicking the invert 
on in the Apply Surface Texture 
og box.

the Amount slider to 66%, and 
e the rest of the settings at their 
ult positions.

k OK. The surface texture is 
lied to the canvas. 

pply Surface texture dialog to add 
ensional depth to your pattern.
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6. Set Opacity to 42% and click OK. The 
entire document is filled with the SEA 
pattern.

The background for your CD cover is 
almost complete. Next you’ll add a surface 
texture to the image.

Lesson 2: Applying Surface 
Textures

In this lesson you’ll use the Apply Surface 
Texture effect to add a three-dimensional 
texture to the background image.

To apply surface texture based on a 
pattern

1. Choose File menu> Clone Source> 
Pattern to make sure that surface 
texture is based on the pattern 
currently active in the Art Materials 
palette.

2. Choose Effects menu> Apply 
Surface Texture. The Apply Surface 
Texture dialog appears.

3. Click the Using pop-up and choose 
Original Luminance. 

Orig
ligh
clon
patt

Usin
area
beco

It is
mak
blac
opti
dial

4. Set 
leav
defa

5. Clic
app

Use the Fill dialog to fill the entire image with 
the SEA pattern.

The Apply Surface Texture dialog lets you add a 
three dimensional surface to you image. 

Use the A
three-dim



ose Edit menu> Copy or press 
mand-C /Ctrl-C.

ct the SEA image and choose Edit 
u> Paste.

 image Flat Moon appears in the 
er of the. 

k the Adjuster tool in the Tools 
tte and drag the pasted image to 
bottom of the document window.

ose File menu> Save, and save 
r document as “Moon Cover.”

 3: Applying Gradations

ons are used to fill an area with a 
f colors. Your gradations can also 
 to create patterns or textures 

hat your document should look like 
’re done.
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Now that you have the completed 
background of your CD cover, you can 
start adding other elements. Next, you’ll 
create a surface texture for the foreground 
image.

To create Surface Texture based on 
image luminance

1. Choose File menu> Open and open 
the file Painter Classic: Tutorial: 
Flat Moon. A new window containing 
an ocean scene appears on the 
desktop.

2. Choose Effects menu> Apply 
Surface Texture. The Apply Surface 
Texture dialog appears.

3. Click the Using pop-up and choose 
Image Luminance.

4. Set Amount to 63%. Leave all of the 
other options at their default settings 
and click OK.

Notice the dramatic change in the 
relief of the image. 

Now that you have both a foreground 
and a background image you can 
combine them. 

To combine images:

1. Select the Flat Moon document 
window. 

2. Choose Edit menu> Select All, or 
press Command-A /Ctrl-A to select 
everything in the window.

3. Cho
Com

4. Sele
men

The
cent

5. Clic
pale
the 

6. Cho
you

Lesson

Gradati
blend o
be used

Flat Moon image is used to create the foreground 
for your CD cover.

Use the Apply Surface Texture dialog to create a 
three-dimensional foreground.

This is w
when you
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k the top-right orientation icon 
s sets the gradation to order from 
t to left.

 settings for the gradation are now 
plete. Next you’ll need to select 
rs.

t primary and secondary colors:

k the Color icon in the Art 
erials palette. The Color controls 
ear.

k the Primary color indicator.

, any color you select is used as 
Primary color.

-

radation orientation icons let you 
e order of colors in the gradation.

ary color is used when you’re painting 
brush or other painting tool.
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depending on the settings you choose. In 
this lesson, you’ll use gradations to create 
a background for the title area of the CD 
Cover.

To create a two-point gradation:

1. Choose File menu> New. The New 
Picture dialog appears.

2. Set the Height = 2 inches, Width = 1.5 
inches and Resolution = 72 dpi.

3. Click the Gradation icon in the Art 
Materials palette. The Gradation 
controls appear.

4. Click the Two-Point gradation icon 
from the palette.

If the Two-Point icon is not available, 
you’ll need to click the pushbar to 
open the palette drawer and select it 
from there. 

Two-Point gradations create a blend 
of color between the Primary and 
Secondary colors in the Art 
Materials: Color palette.

5. Select the radial gradation option 
from the selection of four grad types.

6. Click the expand icon in the top-right 
corner of the Art Materials: 
Gradation palette to display the 
gradation orientation controls.

7. Clic
Thi
righ

The
com
colo

To selec

1. Clic
Mat
app

2. Clic

Now
the The Art Materials:Gradation palette is used to 

create and apply gradations to an area.

The Two-Point gradation uses the selected 
Primary and Secondary colors to create a blend.

The four gradation options let you create radial, 
linear, conical or spiral gradations.

The six g
control th

The Prim
with the 



ble the Gradation option and click 
. 

 entire image is filled with the 
ient.

ose File menu> Save, and save 
r document as “Title Bar.”

ill dialog to fill an area or the entire 
th a gradient.

ific area is selected, the Fill dialog fills 
 image with a selected art material.
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3. Click the Dropper tool in the Tools 
palette.

4. Click the darkest blue color from the 
wave in the “Moon Cover” image.

The color appears in the Controls 
Palette as the front color of the two 
boxes. 

5. In the Art Materials: Color palette 
click the Secondary color icon. 

6. Click the light blue from the “Moon 
Cover” image.

7. Click the Gradation icon in the Art 
Materials palette. The Gradation 
controls appear.

8. The new gradient appears in the 
preview area of the palette.

The setup for your gradient is complete. 
You can now use the new gradient to fill 
an area or the entire image.

To fill an area with a gradation:

1. Choose Effects menu> Fill. The Fill 
dialog appears.

2. Set Opacity is at 100%.

3. Ena
OK

The
grad

4. Cho
you

The Dropper tool lets you pick up color from 
within your image.

The color you click in the Moon Cover image 
becomes the Primary color.

The secondary color is used when you’re painting 
with the image hose or creating gradients.

Once you select a primary an secondary color, 
Painter Classic automatically creates the new 
gradient.

Use the F
image wi

If no spec
the entire
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ction and drag it into the Moon 
er document. 

 selected area remains active in the 
n Cover document. 

g the selection to the lower-center 
e image.

 5: Creating Patterns

 are created by tiling an image 
ly to fill an area. To create your 
tern you first have to create a tile, 
Classic takes care of tiling it to 
 pattern.

esson, you’ll create a new pattern 
ly it to your CD cover.

 selection remains active when you drag 
e new document, you can position it 
 in the image.
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Lesson 4: Adding Paper Textures

Paper textures can make your image look 
like it was painted on rough construction 
paper, or fine parchment. Using the Paper 
controls in the Art Materials palette you 
can add a wide variety of paper textures to 
your image.

In this lesson, you’ll create a paper texture 
and apply it to the title box of your CD 
cover.

To apply surface texture based on paper

1. Select the document Title Bar.

2. Click the Paper icon in the Art 
Materials palette. The Paper controls 
appear.

3. Click the Paper menu and choose 
Hand Made.

4. Choose Effects Menu> Apply 
Surface Texture. The Apply Surface 
Texture dialog appears.

5. Enable the Paper option and click OK. 

The Hand Made paper grain is 
applied to the entire image.

The title bar section of your CD cover 
is complete. Now, you can add it to 
the rest of the CD Cover image. 

To add elements to an image using drag 
and drop:

1. Click the Rectangular Selection tool in 
the Tools palette.

2. In t
sele
Cov

3. The
Moo

4. Dra
of th

Lesson

Patterns
repeated
own pat
Painter 
create a

In this l
and app

The Paper controls let you select a paper type and 
lets you scale the paper grain.

When you create a select Paper in the Apply 
Surface Texture dialog, the current setting in the 
Art Materials: Paper palette is used to create a 
surface texture.

Since the
it into th
anywhere
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h category of brushes lets you paint with 
 such as oils and watercolors.
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The process of creating a seamless tile, 
shown in this lesson, can also be applied 
to creating seamless tiles for web pages.

To create a seamless pattern:

1. Choose File menu> Open and select 
the file Painter Classic: Tutorial: 
Pattern One.

This document will act as the tile for 
your pattern.

2. Choose File menu> Clone. A window 
called “Clone of Pattern One” 
appears.

3. Press Command- A/ Ctrl-A. To select 
everything in the window. 

4. Press delete. The window is now 
blank.

5. Click the Tracing Paper icon on the 
window’s frame. A Tracing paper layer 
appears.

6. Click the wraparound icon at the top- 
right of the document window.

This enables the Wraparound feature. 
When the feature is enabled, you can 
paint off of one edge of the image and 
your stroke will appear on the other 
side. This makes it easy to paint 
seamless, self-tiling patterns.

7. Click the Patterns icon in the Art 
Materials palette. The Pattern controls 
appear. 

The preview area in the palette 
displays your tile as you paint it. 

8. Click the Dropper tool in the Tools 
palette and click the dark blue color in 
the pattern.

9. Clic
Bru

10. Clic
cho

11. Pain
tile.

As y
shap
edg
pain
patt

The file Pattern One will be used to create a tile 
for your pattern.

When the wraparound icon appears as a split 
star, it indicates that the Wraparound feature is 
enabled.

The Brus
materials
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 fonts available in the menu 
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Point Size= 27.

k the center of the title bar and 
 the title of the CD.

en you’re done typing, click the 
uster tool in the Tools palette. 

g the text to the center of the title 
.

k the Text tool in the Tools palette.

rol palette lets you choose a font and 
 to use with the Text tool.

be positioned anywhere in the image 
 string is active.
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If you want to see what you’re 
painting, hold down Shift-Spacebar 
and drag in the direction you want to 
move the tile.

12. Pick up another color from the 
original tile, or pick your own color.

13. Continue painting until you’re 
satisfied with your tile. 

Now that you’re tile is ready, you can use it 
as a pattern to fill an area on your CD 
cover.

To fill an area with a seamless pattern:

1. Click the Rectangle tool from the 
Tools palette.

2. In the Moon Cover document, select 
an area next to the title bar. 

3. Press Command-F/ Ctrl-F. The Fill 
dialog appears.

4. Enable the Pattern option and set 
opacity to 75%. This creates a 
translucent screen. 

If you want to use this pattern again, 
save the file, open it, then use it as a 
clone source. Then using the Fill 
dialog apply the pattern to an area or 
the entire image.

The last thing you’ll need to do to 
complete the CD Cover is add the text.

To add text:

1. Click the Text tool in the Tools palette.

2. In t
pop
Bold

The
dep
syst

3. Set 

4. Clic
type

5. Wh
Adj

6. Dra
box

7. Clic

As you trace the original tile, paint off the edges 
to finish the shapes. This creates a seamless tile.

The area is filled with the pattern you created.

The Text tool lets you add text to an image.

The Cont
point size

Text can 
while the
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8. Click the top of the box to the right of 
the title bar. 

9. Type the name of the author.

Your CD Cover is now complete.

Moving On

Now that you’ve completed this tutorial 
you’re ready to experiment with other art 
materials. Painter Classic provides several 
pre-loaded libraries of patterns, paper 
textures and other elements to add life to 
your images.

You can apply the techniques described in 
this tutorial to any of the art materials. 

For more information on art materials 
refer to the Painter Classic on-line help.

The completed CD Cover.
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Painter Classic provides keyboard 

shortcuts for the two most recently 

used effects:

• Access the last effect used by pressing 
Command-/ or Ctrl+/.

• Access the second-to-last effect used 
by pressing Command-; or Ctrl+;.

Orientation Effects

You can manipulate part or all of your 
image’s orientation by rotating, scaling to 
a larger or smaller size, or flipping 
horizontally or vertically.
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Understanding 
Painter Classic Effects

The Effects menu offers features for 
electronic retouching, color correction, 
sharpening and softening focus, and add 
lighting with control over direction, color, 
and intensity. Orientation effects include 
rotate, scale, and flip. 

Basics of Applying Effects 

Painter Classic’s effects are applied by 
making a selection, choosing a command 
from the Effects menu, setting options, 
and clicking OK. If you do not make a 
selection, the effect will be applied to the 
entire image.

Effects with Previews

Dragging in the Preview area of an e
lets you view specific areas of the ima
addition to providing a before and a
preview of an effect.

Using Fade to Partially 
Undo Effects

The Fade command allows you to un
any percentage of your last effect. Th
great way to achieve just the right am
of an effect.

Recently Used Effects Comm

Sometimes while you are working, yo
want to use the same effect multiple 
times. Painter Classic makes this easy

As you work, you’ll notice that the m
items for the last effects commands y
used are available at the top of the Ef
menu. This makes it easy to choose t
commands again.

Image Effects



erve Center keeps the item 
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g Images 

 Horizontal and Flip Vertical 
t you flip images or parts of 
sing a single menu command. 

image.

e is flipped horizontally.
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Rotating Images

You can rotate all or part of an image 
using the Rotate effect. The effect lets you 
select the exact angle of rotation. 

You can visually rotate the selection in the 
windows while the dialog is displayed. 
Drag the corner of the selection to rotate 
manually. The Rotate Selection dialog 
reflects the numerical value of the angle 
after you release the mouse or stylus. 

You can also rotate by entering the desired 
angle in the dialog. A positive number 
rotates counterclockwise. A negative 
number rotates clockwise.

Scaling Images

The Scale effect lets you change the 
dimensions of part or all of an image. The 
effect lets you enter the exact scale 
percentage.

You can visually scale the selection in the 
windows while the dialog is displayed. 
Drag the corner of the selection to scale 
manually. The Scale Selection dialog 
reflects the numerical percentage after you 
release the mouse or stylus. 

You can also scale by entering the desired 
percentages in the dialog.

The effect also has two options:

• Constrain Aspect Ratio maintains the 
selection’s proportions. Unchecking 
this item lets you change horizontal 
and vertical measurements 
independently. 

• Pres
anch
cent

Flippin

The Flip
effects le
images u

Use the Rotate dialog to rotate an image. 

Use the Scale Selection dialog to resize your 
image. 

Original 

The imag
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ghtness slider adjusts the gamma 
age. Move the slider to the left to 

 gamma, making the image 
r to right to make it darker. Your 

 will be apparent while you’re still 
ialog.

g the gamma adjusts only the 
s of an image and leaves the white 
k areas untouched. 

Lighting

ly Lighting effect lets you shine 
ore light sources on part or all of 

age.

ighting is comparable to hanging 
work in a gallery and adjusting 
spotlights to illuminate it.

 choose different lighting effects 
e presets provided, or you can 
our own effects by defining 
ess, distance, color, and other 
ristics. 

 older 486 computers may lack 

ath coprocessor necessary to for 

pply Lighting effect to function. 

ut this hardware, Apply Lighting 

s appears grayed out.
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Brightness/Contrast

The Brightness/Contrast effect lets you 
adjusts the brightness and contrast of the 
overall image in the RGB format. The 
Brightness/Contrast provides controls for 
adjusting both contrast and brightness 
value.

Equalize 

The Equalize effect improves contrast, 
adjusting black and white points and 
distributing the brightness levels 
throughout the entire range of available 
levels. 

When you initially access the Equalize 
effect, Painter Classic automatically 
adjusts the image so that the lightest color 
is white and the darkest color is black.

You can adjust contrast manually by 
dragging the black and white points in the 
histogram.

The Bri
in the im
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lighter, o
changes
in the d

Changin
midtone
and blac

Apply 
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Use the Brightness/Contrast effect to adjust the 
contrast levels in an image.

The histogram is represented by the silhouette. 
Each peak shows the number of pixels for a 
brightness level. You can adjust white and black 
points by dragging the triangles.



hange the settings for a light, click 
indicator to select it. Then adjust 
sliders to set the color as described 
w.

 also customize the properties of 
s using the sliders at the top of the 
se the following guidelines to 
e sliders:

htness is like a dimmer knob. 
ving it to the left turns down the 
t source, moving it to the right 
eases brightness.

tance controls how far the light is 
 the image. If you move the light 

rce closer, you may have to change 
image’s exposure (see below).

ation sets the light’s angle in 
tion to the canvas. At 90° the light 
ining straight down, and at 1° it’s 

rly horizontal.

ead sets the angle of the light 
e.

osure is the image’s brightness, as 
hotography. Moving the slider to 
left decreases exposure, moving it 
e right increases exposure. 

easing the exposure lightens the 
ge as a whole. Decreasing 
osure darkens it.
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Applying Lighting Presets

The Apply Lighting dialog holds several 
preset lighting environments. You can use 
these directly or as a starting point for 
customized lighting.

The scrolling window at the bottom of the 
dialog contains preset lighting effects in 
the library. When you first open the 
dialog, the first effect is selected (it has a 
black box around it), and its name 
appears under the scroll bar. 

The effect of each type of lighting is 
displayed in the Preview window. 

Customizing Lighting

You can use the controls in the Apply 
Lighting dialog to achieve other lighting 
effects. The Preview window shows your 
changes, so you can experiment and see 
the results. 

A lighting environment can be edited by 
adding, deleting, or adjusting the lights in 
the Preview window. The small part of the 
light indicator is the origin from which 
the light is shining; the large part is the 
point the light shines toward.

Use the following actions to add, delete, 
or adjust lights:

Standard camera-based principles 

apply to editing lighting. For example, if 

you turn up the lights, you may have to 

adjust exposure.

• To move the indicator, drag its 
large end.

• To change the light source direction, 
drag the small end.

• To create another indicator, click 
anywhere else in the Preview window.

• To delete an indicator, click the 
indicator to select it. Then press 
Delete/Backspace. 

• To c
the 
the 
belo

You can
the light
dialog. U
adjust th
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Use the Apply Lighting dialog to create your own 
custom lighting effects, or choose light effects 
from the presets. 
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sh Strokes

h Strokes uses the difference in 
ce between the clone source and 
ent document. This can make 
rokes appear three-dimensional, 
hem the illusion of oil paints.

ne source is specified, the current 
is used to create the surface 

ased on Paper Grain.
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Ambient is the surrounding light in 
an image. If you had no individual 
lights in your image, the ambient 
lighting would govern the overall 
lightness of the image. Moving the 
slider to the left darkens the overall 
lighting; moving it to the right 
increases the light.

Apply Surface Texture

Painter Classic lets you add a 
three-dimensional surface texture to your 
image. You can use this feature to apply a 
paper texture across the image or to give 
depth to the brush strokes of an oil 
painting. 

Some older 486 computers may lack 

the math coprocessor necessary for the 

Apply Surface Texture effect to function. 

Without this hardware, Apply Surface 

Texture always appears grayed out.

If you want, you can apply a paper 

texture when you first create an image, 

then paint or draw over it. But the 

texture is erasable, so you might not 

end up with the same texture across 

the document surface. Generally, you’ll 

add the paper texture as the last step in 

producing artwork.

Types of Surface Textures

There are four types of surface textures 
you can apply to an image:

• Paper

• 3D Brush Strokes

• Image Luminance

• Original Luminance

Paper

Paper applies the current paper texture. If 
the Paper palette is open, you can choose 
different papers and change their scale to 
try different textures. The Preview 
window automatically updates to display 
paper changes. 

3D Bru

3D Brus
luminan
the curr
brush st
giving t

If no clo
pattern 
texture.

Texture b



 Preview window shows how the 
ons look on your image. 

 Surface Textures

ting control in the Apply Surface 
dialog lets you create different 
 effects that to can use to enhance 
uality of the texture. 

y have multiple colored lights 
 with the Paper Grain (from the 
op-up) to produce different 
 effects.

hting Sphere shows all possible 
angles and how the lights 
te them.

y either use the basic positions, 
by the Light Direction radio 
, or you may create custom 
 by working in the sphere.

ight Direction option should be 

only as a starting point to develop 

 complex lighting. If you have 

oped complex lighting with several 

 of different colors and you decide 

 the basic Light Direction control 

ange a light’s direction, it will 

re the default of one light and 

 the color to white.
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Image Luminance

Image Luminance uses the current 
document’s luminance to determine 
where to add surface texture. This will 
emboss on the edges of the imagery. 

Original Luminance

Original Luminance uses the clone 
source’s luminance

The Inverted feature creates an inverted 

version of the option selected from the 

Using pop-up.  

Customizing Surface Textures

The Apply Surface Textures dialog 
provides controls for setting various 
texture properties that can create unique 
effects.

Use the following guidelines to adjust the 
Material sliders to achieve the texture you 
want:

• Picture controls the amount of color 
in the picture. At 100%, the full color 
of the picture shines through. Move 
the slider to the left to remove the 
color to black, leaving only the shine.

• Amount controls how much surface 
texture is applied to the image. 
Moving the slider all the way to the 
right applies the maximum amount.

• Shine controls the highlights. More 
Shine creates an aluminum-foil effect.

The
opti

Lighting
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Texture 
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Texture based on Image Luminance. 
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ect heightens contrast by 
ing highlights and shadows. The 
 dialog lets you set the intensity of 
t, and shadow and highlight 

ies.

following guidelines to adjust the 

ius determines how much of the 
e of an element is affected. The 
her the slider is to the right, the 
er the affected area will be.

hlight determines the intensity of 
bright areas. Move the slider to the 
t to brighten the highlight.

 Sharpen dialog to sharpen the focus. 
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The Show Light Icons checkbox lets you 
hide or show the light icons on the 
Lighting Sphere. 

• To create a new light, click on the 
sphere. A new light icon (small circle) 
appears where you click.

• To change a light’s angle, drag its icon 
on the sphere.

• To select a light, click its icon. Notice 
the selected light has a thicker, dark 
icon. You may change the selected 
light’s color and other characteristics.

• To choose a new color for the selected 
light, click the Light Color color chip. 

• To delete the selected light, press the 
Delete/Backspace key on your 
keyboard.

Setting Light Properties

The bottom of the Apply Surface Texture 
dialog lets you control the properties of 
the lights on the surface.

Use the following guidelines to adjust the 
Light Control sliders:

Brightness indicates the amount of 
contribution of the light to the overall 
lighting color. 

Conc (concentration) adjusts the 
spread of the light’s shine over the 
surface. 

Exposure globally adjusts the overall 
lighting amount from darkest to 
brightest. 

Display affects the lighting Preview 
sphere only. If you have a darker color 
for the display, it can be easier to see 
subtle lighting adjustments.

Sharpe

This eff
intensify
Sharpen
the effec
propert

Use the 
sliders:

• Rad
edg
fart
wid

• Hig
the 
righ

Use the Light controls to set the properties of light 
illuminating the surface texture.

Using the



pply Auto Clone to a large area, 
t may fill smaller rectangular tiles 
 time. If you click to stop the Auto 
t won’t automatically finish the 
 of the overall selected area. To fill 
rectangular areas, you can use 
one with selections. 

an Gogh

cts menu> Auto Van Gogh effect 
ith the Auto Van Gogh variant of 

sts brush. This algorithmic 
h to placing directional brush 
results in a Van Gogh-like 
n of an image.

ct requires two passes. In the first 
inter Classic determines the angles 
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Classic applies the dabs. The 
 rendered in a set of 
nalized brush strokes.

to Van Gogh. 
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• Shadow determines the depth of the 
shadows. The farther the slider is to 
the right, the darker the shadows will 
be.

Soften

This effect increases the transition from 
one part of your image to another, 
enhancing the anti-aliasing of strokes. 
The Soften dialog lets you set the intensity 
of the effect.

The Radius slider sets the amount of 
blurring. The farther the slider is to the 
right, the more steps there will be between 
one image element and another, which 
will mean more blurring. 

Auto Clone

You can have Painter Classic randomly 
apply brush dabs for you, rather than 
creating them yourself with a Cloner 
brush. For information on cloning, refer 
to “Cloning and Tracing” on page 37 

Auto Clone works with different brushes. 
Auto Clone works best with the 
Directional AutoCloner variant of the 
Cloners brush and the Seurat variant of 
the Artists brush. If you want the Seurat 
tool to pick up color from the source 
document, choose Art Materials palette: 
Color menu> Clone Color.

When the right amount of the clone has 
filled in to suit your design, click 
anywhere in the image to turn off Auto 
Clone.
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the pain
one at a
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final tile
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Auto Cl
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Using the Soften dialog to soften the focus. 

An image altered using the Auto Clone effect.

Using Au
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Image Effects Tutorial

Effects in Painter Classic let you quickly 
create complicated art work from simple 
images. Effects can be used to enhance 
poor quality images or create stylized 
photographic effects. Other effects let you 
apply surface textures to your image, or 
create patterns. 

This tutorial will help you explore the 
wide range of effects available in 
Painter Classic. You’ll use the effect to 
prepare the imagery for a corporate 
brochure.
Image Effects 101

The imagery was created by applying 
several effects to a base image and then 
combining it with another image. In this 
tutorial you’ll apply effects to enhance the 
quality of an image, create stylized artistic 
effects, and finally apply a surface texture 
to the image. 
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Lesson 1: Enhancing Images

In this lesson you’ll use the Apply 
Lighting, Equalize, and Soften effects to 
enhance the background image of your 
corporate brochure.

To open the background image:

✤ Choose File menu> Open and select 
the file Painter Classic:Tutorial: 
WINTER TREES.

The background image appears in a 
document window.

The first thing you’ll do to enhance this 
image is add extra colored light sources to 
give the image more depth.

To add light sources to an image:

1. Choose Effects menu> Apply 
Lighting. The Apply Lighting dialog 
appears.

This effect applies additional light 
sources to your image so that it looks 
like it’s being illuminated from 
different areas.

2. Click the Drama icon. 

If th
click
app

3. Clic
dark
app

4. Clic

Next yo
image u

The WINTER TREES image will serve as the 
background image for your brochure.

The Apply Lighting dialog lets you set the 
parameters of the lighting effect.

Drama li
light sour

This is w
additiona
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the Opacity to 33% and click OK.
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To adjust the brightness levels in an 
image:

1. Choose Effects menu> Equalize. The 
Equalize dialog appears.

The Equalize effect improves contrast, 
adjusting black and white points and 
distributing the brightness levels 
throughout the entire range of 
available levels. To achieve this, 
Painter Classic creates a histogram 
showing the number of pixels for each 
brightness level value. 

Equalize allows gamma adjustment, 
which lightens or darkens an image 
without changing highlights or 
shadows.

2. Drag the Black indicator to 84.7.

3. Drag the White indicator to 42.3.

4. Set the Brightness slider to 56.7% and 
click OK.

Next you’ll soften the entire image using 
the Fill dialog. The Fill dialog’s Opacity 
control can be used like a Soften image 
effect to dull the colors in an image.

To soften an image using the Fill dialog:

1. Choose Effects menu> Fill. The Fill 
dialog appears.

2. Ena
Prim

3. Set 

Now tha
backgro
element
interesti

This Equalize dialog lets you adjust the 
brightness levels in an image.

This is what your image looks like after it’s been 
equalized.

The Fill d
sharpnes

This is w
softened.
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Lesson 2: Applying Artistic 
Effects

In this lesson, you’ll use the Auto Van 
Gogh effect to create a very artistic- 
looking image from your original image.

The first step is to adjust the colors in the 
background image to create a more 
interesting Van Gogh effect.

To change image colors using lighting:

1. Choose Effects menu> Apply 
Lighting. The Apply Lighting dialog 
appears.

2. Click the Drama icon.

3. Click the Light Color box and choose 
a dark blue color. This applies the 
dark blue color to the areas within the 
range of the light.

4. Click the Ambient Light Color box 
and choose a light blue color. This 
applies the light blue color to the 
entire image.

5. Set Brightness = 1.18, Distance = 
1.05, Elevation = 8°, Spread = 55°, 
Exposure = 0.75 and Ambient = 0.74 
and click OK.

Now that you have an interesting 
background, you can apply the artistic 
effect.

To appl

1. Sele

2. Cho
clon

3. Sele
win

4. Clic
pale

5. Clic
Bru

6. Clic
Aut

7. Cho
Gog

Pain
the 

Use the Apply Lighting dialog to change the color 
of all the elements in your image.

This is what you’re image should look like with 
the additional lighting.

The Brus

The Artis
artists’ st
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 effect is applied to the image.

chure imagery is almost complete. 
ere are going to be other elements 
over top of this imagery, you 

ake the image a little more 

’ll need to brighten the darker 
 the image.

hat the image looks like when you apply 
ush strokes surface texture.
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The Auto Van Gogh effect places 
directional brush strokes over your 
image, resulting in a Van Gogh-like 
rendition of the original image.

You can see how applying a few effects can 
turn a simple image into a complex piece 
of artwork. Next, you’ll apply surface 
texture to the image.

Lesson 3: Applying Surface 
Textures

In this lesson you’ll use the Apply Surface 
Texture effect to add texture and 3D brush 
strokes to your image. 

The Apply Surface Texture effect can also 
be used to apply a paper texture across the 
image or give depth to the brush strokes 
of an oil painting.

To add 3D brush strokes to an image:

1. Choose File menu> Clone Source> 
WINTER TREES.

2. Choose Effects menu> Apply 
Surface Texture. The Apply Surface 
texture dialog appears.

3. Click the Using pop-up at the top of 
the dialog and choose 3D Brush 
Strokes.

4. Set the Amount slider to 35%. 

5. Set the Shine slider 16% and click OK.

The

The bro
Since th
applied 
should m
subtle. 

First you
areas in

The Auto Van Gogh effect creates a brush stroke 
rendition of the original image.

The Apply Surface Texture dialog lets you set the 
parameters for the three-dimensional surface 
texture.

This is w
the 3D br



g On

ork for your corporate brochure 
lete. Now you can save this 
Classic file and import it into a 
out program to add additional 
s to complete the brochure. 

cts discussed shown in this 
are only a sample of the effects 
e in Painter Classic. Now you can 
the many other effects available. 
niques shown in the tutorial can 

 to apply almost any effect. 

 more about effects, refer to the 
Classic on-line help.
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To brighten dark areas in an image:

1. Choose Effects menu> Equalize. The 
Equalize dialog appears. 

2. Set the Black indicator to 86.6%, 
White to 61.1%, and Brightness to 
59.3%, then click OK.

Then you’ll need to soften the image by 
fading the Equalize effect.

To partially undo an effect:

1. Choose Effects menu> Fade. The 
Fade dialog appears.

2. Set the Fade level to 50%.  

Movin

The artw
is comp
Painter 
page lay
element

The effe
tutorial 
availabl
explore 
The tech
be used

To learn
Painter The Fade dialog lets you partially undo the 

Equalize effect.

This is what your final image looks like after it’s 
been faded.

The Fade dialog lets you partially undo the 
Equalize effect.

This is what your final image looks like after it’s 
been faded.



Scripts 107

o. If 
vert 

ying 
tage 

ros. 
n 
u can 

the 

ol. 
ets 
by 

rs, 
e 

.”

Because Painter Classic saves instructions, 
scripts are efficient and flexible. For 
example, you can play a script one 
instruction at a time. 

The Script Palette

The Script palette provides the tools for 
recording, playing, and storing scripts.

The Script palette contains controls for storing, 
recording, and playing scripts.

The Scripts 
icon

Play 
Controls

Existing Scripts

Pushbar
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Understanding Scripting

Scripts allow you to record every action 
you make in Painter Classic. Scripts are 
similar to video tape. You can record and 
play them back at any time from the 
Script palette. 

When you playback a script, sit back and 
watch Painter Classic do the work. You 
can record anything in a script—from a 
single edit command to an entire work 
session. 

There are a number of ways to take 
advantage of scripting:

• Scripts offers the ultimate in Und
you record your work, you can re
to any stage in the project by pla
the script and stopping it at the s
you want.

• You can use scripts to create mac
If you have a repetitive task, or a
operation you use frequently, yo
record that series of commands. 
Whenever you want to perform 
tasks, play the script.

• Scripts are a great educational to
Playing scripts of an art project l
you see the step-by-step process 
which the image was created.

How Scripts Work

The Script Recorder saves each 
instruction you give Painter Classic, 
including what values, locations, colo
and textures are used. By repeating th
instructions, Painter Classic can 
reproduce the artwork “from scratch

Scripts can be stored in a script library found on 
the Script palette. 

Scripts



 also use Command-./Ctrl+. to 
ript from playing.
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Record and Playback Buttons

Five buttons on the palette make it easy to 
stop, play, record, pause, and step forward 
when you’re working with scripts.

Recording Scripts

The recording process is simply a matter 
of clicking Record, then Stop and then 
naming the script. When you’re done, the 
script appears in the palette.

Playing Scripts

When you play your recorded script, you 
can sit back and watch the operations 
unfold. In Painter Classic, replaying a 
script of a painting is like watching the 
artist at work.

All the scripts available for playback are 
displayed in a row in the Script palette or 
in the palette’s drawer.

You can also use the Script pop-up to 
select a script by name. Click on the Script 
pop-up inside the Script palette and 
choose Load Library to open other Script 
libraries.

If necessary, you may use the Stop, 

Pause, and Step Forward buttons to 

control playback.

You can
stop a sc

Script buttons, from left to right: Stop, Play, 
Record, Pause, and Step Forward. 

Select a script from the Script palette.

Click script pop-up menu to choose a script, or 
load a script library. 
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Scripting Tutorial

As you use Painter Classic, you’ll find that 
there are certain tasks that you tend to 
repeat, such as resizing images. To help 
you save time and perform complex tasks 
more easily, Painter Classic provides the 
Scripting palette. The palette acts as a 
recorder that stores your actions for later 
use. 

This tutorial is designed to teach you how 
to record and play scripts. You’ll learn 
how to use the Scripting palette to both 
set up a script recording and to play back 
Scripts 109

previously recorded scripts. 

In this tutorial, you’ll use scripts to record 
the creation of a complex piece of art 
work, and to automate image resizing. 

To learn more about Scripting, refer to 
Painter Classic’s on-line help.



t over the outline of the corner 
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ose a dark yellow color from the 
Materials: Color palette.
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Lesson 1: Recording Scripts

In this lesson you’ll use the Scripts palette 
to record a script for the creation of a 
corner piece.

To record a script:

1. Choose Window menu> Show 
Scripts to display the Scripting 
palette.

2. Choose File menu> Open and select 
the file Painter Classic: Tutorial: 
Corner. 

A document window opens 
displaying an outline of the corner 
piece. This file will act as a painting 
guide.

3. Press the Record button on the Script 
palette. The Record button glows red 
while you are recording a script. 

4. Choose the Brush tool in the Tools 
palette.

5. Click the Pen category in the Brushes 
palette.

6. Click the variant pop-up and choose 
Scratchboard Tool.

7. Click the Color icon in the Art 
Materials palette. The Color controls 
appear.

8. Choose a light brown color.

9. In the Controls palette, set Size = 1.4.

10. Pain
piec

11. Cho
Art 

12. Use
outl

The Record button in the Scripting palette starts 
the recording of your script.

The Brush tool lets you paint with a variety of 
art materials.

The Pen category of brushes lets you simulate 
painting materials such as inks.

Set the color controls to this position to select a 
light brown color.

As you pa
recorded 

Set the co
select a d

The pain
image wi
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ter Classic paints a new figure 
 the image.

r artwork is almost complete. The 
thing you’ll need to do is add the 
er pieces to the border.

elements to an image:

k the Lasso tool in the Tools 
tte. 

u click Play, Painter Classic performs all 
necessary to paint a new figure into the 

o tool lets you create freehand selections.
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13. Press the Stop button. 

14. Enter the name Corner Piece in the 
dialog that appears. The Corner Piece 
script appears in the Scripts palette.

The script for your corner piece is 
now complete. 

Lesson 2: Playing Scripts

Now that you’ve created a script, you can 
play it back to re-create the artwork. In 
this lesson you’ll play back a script to add 
a complex element to your image. 

Before you can play back a script, you’ll 
need to load it.

To load a script:

1. Click the scripts pop-up menu in the 
Scripts palette and choose Load 
Library. 

2. In the Load dialog, locate the 
Painter Classic: Tutorial: Drunken. 
The selected script appears in the 
Scripts palette. 

To play back a script:

1. Choose File menu> Open and select 
the file Painter Classic: Tutorial: 
Excesses. 

A new document window appears.

2. Click the Drunken icon in the Scripts 
palette.

3. Click the Play button.

Pain
into

You
last 
corn

To add 

1. Clic
pale

The Stop button tells Painter Classic to end a 
recording session. 

The top row of the Scripts palette displays all the 
loaded scripts. 

The Play button starts a script playback.

When yo
the steps 
image.

The Lass
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w document. 

e sure this document has 
portionately larger dimensions. 
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es, and 72 dpi — so this time 

n a new image at 8 inches by 8 
es and 300 dpi to double the size 

our original drawing. 

s Command-A/ Ctrl-A to select 
whole canvas. 

k Corner 2 in the Scripts palette. 

k the Play button. 

g On

t you’ve learned how to create 
 back scripts, you’re ready to start 
enting with the Scripts palette. 

e techniques discussed in this 
 you can set up scripts to 
te repetitive tasks or to store 
 artwork for later use. 

out more about scripts, refer to 
ter Classic on-line help.
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2. Click the Untitled document and 
select the corner piece.

3. Copy and Paste the selection into the 
Excesses window. 

4. Position the corner piece at one 
corner of the border.

5. You can copy and paste the remaining 
three corner pieces, or you can play 
the Corner Piece script to re-create 
the artwork.

Lesson 3: Creating 
Resolution-Independent Scripts

When you create a resolution- 
independent, the size and resolution of 
the artwork is not recorded. This allows 
you to play the script using a different size 
or resolution. 

In this lesson, you’ll record a 
resolution-independent script using the 
corner piece artwork and play it back at a 
higher resolution.

To record for resolution-independent 
playback:

1. Choose File menu> Open and select 
the file Painter Classic: Tutorial: 
ScriptArt1.

This document is 1 inch by 1 inch in 
size and its resolution is set at 72 dpi.

2. Before painting or drawing, press 
Command-A /Ctrl-A to select the 
entire canvas. This allows you to play 
the script back at a higher resolution 
later.

3. Click the Record button on the Scripts 
palette. 

4. Trace over the lines in the image using 
the Pen category: Scratchboard tool. 

Refer to Lesson 2 in this tutorial for 
more detailed instructions.

5. Press the Stop button when you are 
finished, then name your script.

6. Enter the name Corner 2 and click 
OK.

The script appears in the Scripts 
palette.

Now that you’ve created a 
resolution-independent script, you can 
play it back at a different size.

To play 
resoluti
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To find 
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Once you select the corner piece, you can drag it 
into another document.
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Windows options are contained in the 
File menu > Print Setup dialog. 

Size to Fit Page

Choose this option if you want 
Painter Classic to shrink an image that is 
larger than a selected page size. For 
example, when this option is checked, a 
12” x 12” image would be resized to fit on 
an 8 1/2” x 11” page. Painter Classic 
resizes the image to fit the page. 

If an image is larger than the page size and 
you haven’t checked Size to Fit Page, you’ll 
see an alert message when you print. Click 

dard 
ion. 

The Windows Print Setup dialog has controls 
specific to your printer.
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Understanding Printing

You can print Painter Classic images on 
many kinds of printers, including 
PostScript and Windows GDI printers 
and high-resolution imagesetters.

Although your final goal may be to print 
high-quality color prints, it’s a good idea 
to first print proofs on any printer you 
have available. 

You can use a black and white printer to 
check page size and placement of images 
on the page. If you have a color printer, 
you can print proofs to get a general 
impression of what your image looks like. 
Keep in mind that the proof will not be an 
accurate representation of a final print 
produced by an offset printing process. 
The print process, inks, and paper types 
all combine to affect the final output.

Page Setup (Macintosh) a
Print Setup (Windows)

Options for setting up your file for 
printing depend on several factors—
output device, color versus black and
white printing, and whether or not y
are printing separations.

Macintosh options are located in the
menu > Page Setup dialog. 

The Macintosh Page Setup dialog has stan
Apple controls and the Size to Fit Page opt

Printing



ck Color Quickdraw/GDI 
ting if your printer is not a 

tScript printer. Some common 
ples are the Hewlett-Packard 

kJet, the Canon BubbleJet, and the 
on Stylus. You cannot print 
rations to non-PostScript 
ters. 

ck Color PostScript if you plan to 
t to a color PostScript device. The 
S ColorScript and Tektronix color 
mal printer are examples of color 
tScript printers.

 versions of the Painter family 

ed a PRINTER.STG file that 

ined color calibration information 

taining a high quality color 

ation based on the settings: Dot 

16%, Screen Frequency for all four 

ss colors at 133 lpi, and Angle set 

° for cyan, 75° for magenta, 0° 

llow, and 45° for black. 

er Classic does not limit your files 

se settings, it uses the device’s 
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to EPS format with Output Preview 
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o separation tables with your 

e’s default screening.
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Continue, and the image will be clipped 
to fit the page. Click Cancel to stop 
printing. You can then open the Page 
Setup (Macintosh) or Print (Windows) 
dialog and choose Size to Fit Page. 

Size to Fit will also increase the image size 
to fill the whole page.

Using the Print Dialog 

Once you have chosen options in the 
Page/Print Setup dialog, you are ready to 
print.

To print an image:

1. Choose File menu> Print to open the 
Painter Classic Print dialog. The top 
half of the dialog contains the 
standard print commands.

2. Select one of the four printing 
methods Painter Classic supports.

Che
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The Print dialog has standard controls for 
printing. Painter Classic-specific controls are at 
the bottom. 
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 allow your image to fit. The new 
ntation will be visible when you 
 the “i” icon.

 the Size to Fit Page option under 
 menu> Page Setup/Print. 
cting this option will always make 
r image fit the maximum 
table dimensions. This means 
 if your image is large, 
ter Classic will shrink it to fit. 
 if your image is small, 
ter Classic will enlarge it to fit.

soft maintains a large library of 

ows-related printing information 

s available on the World Wide 

 Connect to the Microsoft 

ledge Base at— http://

microsoft.com/kb

ns for Files Saved 
S

 in EPS for Printing

Classic’s EPS files conform to the 
 Color Separation format 

CS format). Although 
Classic save files in EPS-DCS, it 
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Check Separations to print 
separations. The output consists of 
four pages, one each for cyan, 
magenta, yellow, and black. You can 
print separations from Painter Classic 
with any PostScript device, including 
high-resolution imagesetters. 

Painter Classic places a color bar, 
registration marks, and color name 
on each of the four separated plates. 

Check the B & W PostScript box if 
you are printing on a black-and-white 
PostScript laser printer. 

Printing Tips

Size and Orientation

Most printers cannot print across the 
entire page. Any given printer has a 
maximum printable area, which is largely 
determined by the paper handling 
mechanism. For example, the maximum 
printable area on an 8 1/2 “x 11” sheet of 
paper may be 7 1/2 x 10”. 

If you have a printer selected, you can 
visually confirm if your image fits by 
clicking and holding on the “i” icon in the 
lower left corner of the image window. 
This will pop-up a print preview box. The 
rectangle with the “X” in it represents 

your image. The white box is the printable 
area of the page, and the gray border is the 
non-printable area. If your image is too 
large to fit, you have several options:

• Use the Canvas menu> Resize 
command. Enter a lower value for 
either the width or the height. For this 
purpose, it’s easiest to set the 
measuring units to inches or 
centimeters, not pixels.

• Change the printer page orientation 
from portrait to landscape or 
vice-versa. This is done in the File 
menu> Page Setup/Print dialog. 
Depending on your image 
dimensions, changing the orientation 

may
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click
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When you click and press down on the “i” icon in 
the lower left corner of the image window, a 
print preview shows you how your image will 
print on the printer’s page. 
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can’t read EPS-DCS. If you plan to save an 
image in EPS-DCS, it’s a good idea to save 
it in another format first so you will have a 
copy of it that you can reopen in 
Painter Classic.

When you save a file in EPS-DCS, 
Painter Classic opens the EPS Options 
dialog. 

Although you can save your images as 

EPS separations, Painter Classic can’t 

open or edit CMYK files.

Hex (ASCII) Picture Data

This is just another way of storing 
PostScript information. Some programs 
require that this option be checked. The 
file size will be approximately twice as 
large when the file is saved with this 
option.

Preview Options

The radio buttons under Preview Options 
tell Painter Classic whether to save 
preview data and in what format: No 
preview, Black and white preview, 
or Color preview. 

If you have an older laser printer, you may 
have to use the black and white preview to 
print these files on your laser printer. 
Although the preview or display is black 
and white, the color information remains 
intact. If you are going to create on-line 
documents as well as printed 
documents—for example a PDF—be sure 
to choose a high quality color preview.

The EPS Options dialog. 
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Index

Numerics
3D Brush strokes

adding 105

A
Acquire

command 32
Plug-ins 32
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Adjuster tool 16
Adobe Type 1 fonts 28
Ambient slider 97
Amount slider

Apply Surface Texture 98
Apply Lighting command 95
Apply Lighting dialog 96
Applying

image effects 93
applying 104
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tutorial 83
Art Materials palette
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Distorting
image floaters 69

Documents
closing 32
creating 21
EPS format 32, 116
opening 23
opening existing 23
preferences 33
resolution 22
saving 29
saving in different formats 32, 116
set-up 22

Dots per inch (dpi), setting 22
Drag and Drop features 28
Draw Anywhere mode 67
Draw Inside mode 67
Draw Outside feature 73
Draw Outside mode 67
Drawers

locking items in 19, 20
selecting items from 19
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using 19

Drawing
straight lines 52
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Drawing modes 67
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Information button, scroll bar 26

J
JPEG file format

opening 23
saving 31

K
Kerning,text 29

L
Lasso tool 16, 68

using 71
Leaving program 32
Libraries

defined 20
loading alternate 20
nozzles 59
switching 20

Light
adding to images 102

Light Control sliders 99
Light Direction radio button 98
Lighting effects

Ambient slider 97
applying 95
Brightness slider 96
Distance slider 96
Elevation slider 96
Exposure slider 96
Spread slider 96

Lines
drawing 52

Lines per inch (lpi), setting 22
Loading

patterns 84
scripts 111

Locking
drawers 19, 20
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Orientation 93
image size 27
rotating a selection 94
scale 94

Orientation command 69
Original Luminance option

surface textures 98
Oval Selection tool 16

P
Page setup

image size information 27
using 113

Paint Bucket tool 15
filling with 82

Paintbrush file format, opening 23
Painter program, exiting 32
Painting

tutorial 50
using image hose 63

Palettes 13
collapsing 17
Control 13
expanding 17
hiding 17
multi-level 18
rearranging 16
tearing off 17
Tools 13
using drawers 19
viewing 17

Paper color
changing existing color 23
setting 22

Paper command 97
Paper textures 80

applying 97
selecting 80

Pattern palette 81
Patterns

applying 84
creating 89
creating seamless 90
loading 84

Phone support xi

Photoshop
opening files 23

Physical memory usage, setting 35
PICT/PCT file formats, opening 23
Picture slider 98
Pixels per inch, setting 22
Playing

scripts 111
Plug-ins

Acquire 32
exporting 33
filter 32
raster 34
using 32

Point-to-point
cloning 45

Preferences
Brush Tracking 34
setting 33
Windows 35

Preferences command
Brush Tracking 34
General 33
Windows 35

Preserve Center option 94
Pressure

sensitivity, setting 33
Preview window

Grad palette 79
Primary color rectangle 78
Print banding 35
Print dialog box, using 114
Print Setup, using 113
Printing 113

EPS file format 115
orientation 115
page setup 113
Print dialog box 114
Print Setup 113
size 115
tips 115

Printing options 35
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Quickdra
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S
Sampling

colors 78
dropper tool 78

Save As command 29
Saving

documents 29
EPS file format 115
EPS format 31
GIF format 30
JPEG format 31

Scale command 69
Scale Selection dialog 94
Scale, adjusting 94
Scaling

text 29
Screen appearance 22
Scripts 107

palette 107
How Scripts Work 107
loading 111
play back 111
playing 111
recording 110
recording scripts 108
resolution-independent 112
Script buttons 108
tutorial 109

Scroll bar information button 26
Scrolling images, with Grabber tool 25
Seamless patterns

creating 90
Seamless tiles

creating 43
Secondary color rectangle 78
Selecting

colors 77
Selections

adding to 68
creating 68, 71
drawing modes 67
subtracting from 68
tutorial 70
understanding 67
using 67
using for masking 72
warning on drawing outside 33
working with 67

Separations option, printing 115
Seurat brush, Auto Clone and 100
Shadow slider

Sharpen effect 100
Sharpen effect 99
Shine slider 98
Shortcuts

centering image 25
rotating images 26

Show Light icons
Surface Texture 99

Show palettes 17
Size

canvas 27, 28
image 27

Size slider
Controls palette 48

Size to Fit Page setting 113
Soften effect 100
Spread slider 96
Stylus

using 49
Stylus, setting sensitivity of 33
Subpalettes 17
Subtracting from selections 68
Surface Control commands

Apply Surface Texture 97
Lighting Effects 95

Surface Textures
applying 97, 105

Surface textures
based on image luminance 86
based on paper 89
based on patterns 85
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Technical Support xi
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W
Water Color

painting with 55
Web support xi
Wet Layer

painting on 55
Width setting 21
Window menu

Hide/Show palettes 17
Windows

preferences 35
Windows options, setting 35
Wraparound

tiles 44

Z
Zoom

changing levels 25
fit to screen 24
in and out 24
specific area 25

Zoom Level pop-up menu 24
Zooming images, area-averaging and 33
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MetaCreations Corporation is not 
responsible for any costs including, but not 
limited to, those incurred as a result of lost 
profits or revenue, loss of time or use of the 
software, loss of data, the costs of recovering 
such software or data, the cost of substitute 
software, claims by third parties, of other 
similar costs. In no case will MetaCreations 
Corporation’s liability exceed the amount of 
the license fee.

The warranties provided give you specific 
legal rights. You may have other rights which 
vary from state to state. Some states do not 
allow the exclusion of incidental or 
consequential damages, or the limitation of 
how long an implied warranty lasts, so some 
of the above may not apply to you.

7) U.S. Government Restricted Rights 

MetaCreations Painter Classic and 
documentation thereto are provided with 
RESTRICTED RIGHTS. Use, duplication or 
disclosure by the Government is subject to 
restrictions as set forth in subparagraph 
(c)(1)(ii) of the Rights in Technical Data and 
Computer Software clause at 52.227-7013. 
The contractor/manufacturer of 
Painter Classic and documentation thereto 
is MetaCreations Corporation, P.O. Box 
66959, Scotts Valley, CA 95067-6959, 
(408) 430-4000.
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MetaCreations License Agreement
THIS LICENSE AGREEMENT IS A LEGAL 
AGREEMENT BETWEEN YOU, THE END 
USER, AND METACREATIONS 
CORPORATION. IT IS A LICENSE 
AGREEMENT AND NOT AN 
AGREEMENT FOR SALE. PLEASE READ 
THIS LICENSE AGREEMENT 
CAREFULLY BEFORE LOADING AND/
OR USING THIS SOFTWARE. IF YOU DO 
NOT AGREE WITH THE TERMS AND 
CONDITIONS OF THIS LICENSE 
AGREEMENT, PROMPTLY RETURN THE 
PACKAGE TO THE PLACE YOU 
OBTAINED IT AND YOUR MONEY WILL 
BE REFUNDED.

MetaCreations Software License

1) License 

This software can only be used on a single 
computer at any one time. This means that 
the software should be loaded on only one 
hard drive at a time. If you wish to use this 
software on more than one computer, you 
must either erase the software from the first 
hard drive when you move the software to a 
second hard drive, or else purchase two 
copies of the software. You may not under 
any circumstances have this program loaded 
onto the hard drives of two or more 
computers at the same time. You also may 
not copy this software onto a hard drive and 
then use the disks on another computer. The 
software may be executed from a common 
disk shared by multiple computers provided 
that one authorized copy of the software has 
been licensed for each computer executing 
the software.

2) Copyright 

This software is owned by MetaCreations 
and is protected by United States copyright 

laws and international treaty. By law, you, 
the end user, may do the following:

a) make a copy of the software solely for 
backup or archival purposes; or

b) transfer the software to a single hard disk, 
provided you keep the original solely for 
backup or archival purposes.

United States copyright laws prohibits you 
from making any other copy of the software 
for any reason without our permission. 
These federal copyright laws also prohibit 
you from copying the written materials 
accompanying the software without first 
obtaining our permission. 

3) Restrictions 

You may not rent, lend, lease, or assign this 
software. You may, however, transfer the 
software and the accompanying written 
materials on a permanent basis. When you 
transfer the software on a permanent basis, 
you may not keep any copies, and you must 
remove the software from your hard disk. 
Also, the person to whom you transfer the 
software must agree to the terms of this 
License.

You may not alter, modify or adapt the 
software or accompanying materials. In 
addition, you may not translate, decompile, 
disassemble or reverse engineer the 
software. You also may not create any 
derivative works based on this software. A 
derivative work is defined as a translation or 
other form in which the software may be 
recast, transformed or adapted.

4) Limited Warranty 

MetaCreations Corporation warrants that 
this program will perform in substantial 
compliance with the published 
specifications and documentation supplied 
in this package, provided it is used on the 

computer hardware and with the operating 
system for which it was designed. This 
warranty is limited to a period of 90 days 
from the date of the original purchase. 

MetaCreations Corporation warrants that 
the original disks and documentation are 
free from defects in material and 
workmanship, assuming normal use, for a 
period of 90 days from the date of purchase.

5) Remedies 

If you report a significant defect in 
performance of the software in writing, 
within 90 days of purchase, MetaCreations 
Corporation will attempt to correct it or, at 
its option, authorize a refund of your license
fee.

If a defect in the disk or documentation 
occurs during this period, you may return 
the faulty disk or documentation, along 
with a dated proof of purchase, and 
MetaCreations Corporation will replace it 
free of charge.

6) No Other Warranties 

Except as specifically provided above, 
MetaCreations Corporation makes no 
other warranty or representation, either 
express or implied, with respect to this 
software, the disks or documentation, 
including their quality, merchantability, 
or fitness for a particular purpose. In no 
event will MetaCreations Corporation be 
liable for direct, indirect, special, 
incidental, or consequential damages 
arising out of the use or inability to use 
the software or documentation, even if 
MetaCreations Corporation has been 
advised of the possibility of such damages

The warranties and remedies set forth above
are exclusive and in lieu of all others, oral or
written, express or implied.
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Worksheet

Intermittently Once only

see if the solution to the problem is 

o

,

intosh 

n all Extensions are off? Yes/No
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tacreations.com, to 

wing conditions? 

 step by step: 

Mac

s/No Whe

s/No
MetaCreations P
Troubleshooting 

MetaCreations Technical Support 

Phone: (408) 430-4063 

Fax: (805) 566-6359 

Date: __________________________________

Do symptoms appear: Consistently

Description of Problem: 
Your Name: ____________________________

Phone:_________________________________

Fax: ___________________________________

❐ Macintosh ❐ Windows

System Software version: __________________

MetaCreations Software version (ex. 4.1.2)

Found on the splash screen: _____________________

Serial #: ________________________________

Have you checked our Web site, www.me
already posted?  ❐ Yes ❐ No

Does the problem still occur under the foll

Describe how to duplicate the problem

1)

2)

3)

4)

Windows 

Using Standard VGA video driver? Ye

When all TSRs are off? Ye
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